Provider Portal User Guide

Version 6.1
# Table of Contents

Document Overview .................................................................................................................. 5

Purpose of this Document ........................................................................................................ 5

Intended Audience ................................................................................................................... 5

What’s New in this User Guide? ............................................................................................... 5

Assistance ................................................................................................................................ 5

Accessing the Provider Portal .................................................................................................. 6

Creating a Provider Portal Account ........................................................................................ 6

Troubleshooting a Provider Portal Account Error Message .................................................. 12

Provider Portal Returning User .............................................................................................. 13

Log on Process ........................................................................................................................ 13

Password Recovery .................................................................................................................. 13

Change Password Process ...................................................................................................... 15

Provider Dashboard ................................................................................................................ 17

Update Provider Portal User Account Information ................................................................. 17

Multiple Sites .......................................................................................................................... 19

Manage Sites ........................................................................................................................... 19

Manage Users .......................................................................................................................... 22

Adding a User .......................................................................................................................... 24

Adding a Business Administrator to Multiple Sites ............................................................... 27

Inactivating a User ................................................................................................................... 29

Provider Cost of Care Estimate .............................................................................................. 30

Broadcast Messages (not yet available) ................................................................................ 35

Coalition Messages .................................................................................................................. 35

Frequently Used Links ............................................................................................................. 36

Completing the Provider Profile .............................................................................................. 36

Request Assistance .................................................................................................................. 36

Business .................................................................................................................................. 39

Profile ..................................................................................................................................... 41

Step 1 – General ..................................................................................................................... 43

Step 2 – Facility ....................................................................................................................... 44

Step 3 – Services ..................................................................................................................... 48

Step 4 – Curriculum ................................................................................................................. 49
Step 5 – Fees & Discounts ................................................................. 49
Step 6 – Hours of Operation ............................................................ 50
Step 7 – Staffing & Capacity .............................................................. 51
  Example: Child Care Center 1 ....................................................... 53
  Example: Child Care Center 2 ....................................................... 53
  Example: Family Child Care Homes 1 ......................................... 54
  Example: Family Child Care Homes 2 ......................................... 54
  Example: Family Child Care Homes 3 ......................................... 55
  Example: Family Child Care Homes 4 ......................................... 55
  Example: Large Family Child Care Homes 1 ................................. 56
  Example: Large Family Child Care Homes 2 ................................. 56
Step 8 – Private Pay Rates ............................................................... 57
Step 9 – Closures Calendar .............................................................. 58
Step 10 – Documents ...................................................................... 59
Step 11 – Review ............................................................................ 60
Step 12 – Sign and Certify ............................................................... 61
Managing a Profile as a Provider Portal User ........................................ 62
  Provider Dashboard ..................................................................... 62
Managing Contracts ....................................................................... 64
  Managing Documents .................................................................... 65
    Viewing/Uploading Documents ..................................................... 65
    Archiving Documents .................................................................. 67
Provider Contracting ...................................................................... 69
SR Contract .................................................................................... 69
  Provider Eligibility and Notification ................................................ 70
  Provider Responsibilities and Scope of Work ..................................... 70
  Signature Authority ...................................................................... 71
  Exhibit 1: Program Assessments .................................................... 72
  Exhibit 1: Child Assessments ......................................................... 73
  Exhibit 3: Quality Improvement Plan Selection ................................ 75
  Exhibit 5: Provider Reimbursement Rates ....................................... 76
  Exhibit 6: Holiday Schedule .......................................................... 76
Preview Contract ............................................................................. 77
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Execution</td>
<td>79</td>
</tr>
<tr>
<td>Contract Certification</td>
<td>81</td>
</tr>
<tr>
<td>VPK Contract</td>
<td>83</td>
</tr>
<tr>
<td>Compensation and Funding: Advance Pay Options</td>
<td>84</td>
</tr>
<tr>
<td>Exhibit 1: Provider Location List Attachment</td>
<td>85</td>
</tr>
<tr>
<td>Preview Contract</td>
<td>85</td>
</tr>
<tr>
<td>Contract Execution</td>
<td>87</td>
</tr>
<tr>
<td>Contract Certification</td>
<td>89</td>
</tr>
<tr>
<td>VPK-APP</td>
<td>91</td>
</tr>
<tr>
<td>Step 1 – Attendance Policy</td>
<td>91</td>
</tr>
<tr>
<td>Step 2 – VPK Director</td>
<td>92</td>
</tr>
<tr>
<td>Step 3 – VPK Instructors</td>
<td>93</td>
</tr>
<tr>
<td>Step 4 – VPK Calendars</td>
<td>94</td>
</tr>
<tr>
<td>Step 5 – VPK Class(es)</td>
<td>98</td>
</tr>
<tr>
<td>Step 6 – Review</td>
<td>99</td>
</tr>
<tr>
<td>Step 7 – Certify and Submit</td>
<td>100</td>
</tr>
<tr>
<td>Updating a VPK-APP</td>
<td>101</td>
</tr>
<tr>
<td>VPK Director</td>
<td>101</td>
</tr>
<tr>
<td>VPK Instructors</td>
<td>102</td>
</tr>
<tr>
<td>VPK Calendars</td>
<td>106</td>
</tr>
<tr>
<td>VPK Class(es)</td>
<td>110</td>
</tr>
<tr>
<td>Editing an SR Contract Amendment</td>
<td>113</td>
</tr>
<tr>
<td>Viewing a Certified SR Contract Amendment</td>
<td>121</td>
</tr>
<tr>
<td>Editing a VPK Contract Amendment</td>
<td>122</td>
</tr>
<tr>
<td>Viewing a Certified VPK Contract Amendment</td>
<td>128</td>
</tr>
<tr>
<td>Enrollments - VPK</td>
<td>129</td>
</tr>
<tr>
<td>Request/Change Enrollment</td>
<td>129</td>
</tr>
<tr>
<td>Enrolling a VPK Child</td>
<td>130</td>
</tr>
<tr>
<td>Managing VPK Enrollment</td>
<td>133</td>
</tr>
<tr>
<td>VPK Bulk Enrollment Process</td>
<td>141</td>
</tr>
<tr>
<td>VPK-20 Contract Verification</td>
<td>146</td>
</tr>
</tbody>
</table>
Enrollments - SR

Pending Family Acceptance Status
Viewing Enrollments in Pending Family Acceptance
Ending Enrollments in Pending Family Acceptance
Cancelling Enrollments in Pending Family Acceptance

SR Eligibility Redeterminations
Upcoming Eligibility Redeterminations
Past Due Eligibility Redeterminations

Temporary Closures
Creating a Temporary Closure for a Whole Site Closure
Creating a Temporary Closure for all or some SR Care Levels.
Creating a Temporary Closure for all or some VPK Classes.

VPK Non-Reimbursable Temporary Closures
Update VPK Class Calendar

Attendance Rosters

Attendance - VPK
Submitting Attendance Online
Submitted Attendance
Rejected Attendance
Approved Attendance
Uploading Bulk Attendance File

Attendance - SR
Submitting Attendance Online
Submitted Attendance
Rejected Attendance
Approved Attendance

Request for Registration Fee Payment
Dismiss Children

SR Reimbursement Rate Plan
Document Revision History

<table>
<thead>
<tr>
<th>Document Version</th>
<th>Date</th>
<th>Author</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.9</td>
<td>07/28/22</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>5.10</td>
<td>08/25/22</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>5.11</td>
<td>09/27/22</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>5.12</td>
<td>10/30/22</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>6.0</td>
<td>01/26/23</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>6.1</td>
<td>02/23/23</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
</tbody>
</table>

Document Overview
This document provides a step-by-step guide to navigate the Provider Portal.

Purpose of this Document
The purpose of this document is to provide Provider Portal users with a reference document to successfully navigate and perform business processes included in Release 6.1 of the Provider Portal.

Intended Audience
The intended audience for this document includes provider staff responsible for completing profiles, contracts, enrollments, and attendance.

What’s New in this User Guide?
New text and screenshots for Department of Defense Contractor question, editing an SR/VPK Amendment, and Temporary Closures.

Assistance
If you have questions about any of the material in this user guide or about any processes not covered by this guide, please contact your local Early Learning Coalition.
Accessing the Provider Portal
The link to access the Provider Portal is https://providersonservices.floridaearlylearning.com.

Creating a Provider Portal Account
First-time Provider Portal users must register for an account to access the Provider Portal. Provider Portal users with multiple provider sites should begin by registering only one site location. This could be the provider’s primary, flagship or main location. Once a Provider Portal account registration request is approved for one provider site, the provider user will be able to create accounts for additional sites after logging on to the Provider Portal.

Click the here link to start the new account registration process and the following page will display:

A Provider Portal user must enter the taxpayer identification number (from the provider), the provider identification number (from the early learning coalition) and the Department of Children and Families (DCF) license, registration, exemption number or type the word “EXEMPT”. Providers may enter “EXEMPT” if they do not have an exemption number from DCF.

The Provider Portal user must click the Verify License Details button to complete step 1 of the Provider Portal account registration process.
If a match is found for the submitted information, the following message will display:

**Provider Data Found**

We found the following Provider data which corresponds to the license information that you entered. If we've correctly identified your provider, click Yes to pre-fill sections of the registration form. Otherwise, click No and try again with different license information.

- **Business name**: 4 Kids Academy
- **Doing Business As name**: 4 KIDS ACADEMY
- **Owner name**: SARINA

Is this your provider?

[Yes] [No]

If the information is not correct, click the **No** button and contact the local early learning coalition.

If the information is correct, click the **Yes** button. On the next screen, the registration information will be populated by the system, with the exception of User Information.

If a match is not found for the provider information, the following message will display:

**No Matching Provider Data Found**

**Taxpayer or Provider ID:**

**License/Registration/Exemption #:**

We were not able to find matching provider site or principal business data to the specified taxpayer/license information. If you are a new provider, this situation is to be expected.

If you have reason to expect that your information should be in our provider system, please re-enter your license information and try again or contact your early learning coalition for assistance.
After filling in the required information (noted with a red asterisk *), the Provider Portal user must click the **Register** button to complete the registration process.

**License Details**

**Taxpayer or Provider identification number**  
34534534545

**License/Registration/Exemption number, or EXEMPT**  
EXEMPT

**Business Details**

**Business name associated with your taxpayer identification number**

**Owner/Operator name**

**Principal Address line 1**

**Principal Address line 2**

**Principal City**

**Principal State**

**Principal Zip code**
Location Details

☐ Redlands Christian Migrant Association (RCMA) Provider

Doing Business As name (DBA)*

Provider type*

Not Selected

Legal status*

Contact person phone number*

Physical Address of Facility

☐ Facility address is the same as principal address.

Address line 1*

Address line 2

City*

State

Florida

Zip code*

County of physical location*

--please select a value--
User Information

First name

Middle name

Last name

Account user name (must be a valid email address)

Confirm account user name

Password (must contain at least 8 characters)

Confirm password

Register
After clicking the **Register** button, the following message may display:

Click the **Select this** radio button to accept the standardized United States Postal Service (USPS) address or the Entered Address if the USPS Address is not found. Then, click the **Apply** button to continue. If the Provider Portal user clicks the **Close** button, the user will be taken back to the previous screen to re-enter the address information.

Once the Provider Portal user submits an account request, the following page will display:

The Provider Portal user should access the email address used in the account and find the email sent by **DONOTREPLY@oel.myflorida.com**.

If the registration request is approved, the following email will be sent by **DONOTREPLY@oel.myflorida.com**.
The Provider Portal user can log on to the Provider Portal at [https://providerservices.floridaearlylearning.com](https://providerservices.floridaearlylearning.com).

**Troubleshooting a Provider Portal Account Error Message**

If the Provider Portal user receives the following message, contact the local early learning coalition to verify that the taxpayer identification number matches the DEL database.

**The license number belongs to a provider/business that is associated with a different taxpayer identification number.**

If the Provider Portal user receives either of the following messages, contact the local early learning coalition to determine if a provider portal account has already been created.

**The license number belongs to a provider that is already associated with a registered account.**

The taxpayer or provider identification number belongs to a business that is already associated with a registered account.

If the Provider Portal user receives the following message, contact the local early learning coalition to determine if the user name (email address) has been used in the Family Portal. The coalition may need to consult with DEL to make this determination. If a user name has been used in the Family Portal, even if an application was not created, DEL will have to remove the user name from the database so it can be used in the Provider Portal. If a provider has improperly used a user name to complete SR or VPK applications for a parent, the provider must contact that parent to get a replacement user name for that application so the provider’s user name can be used in the Provider Portal. Another option is for the provider to pick another user name to use in the Provider Portal.

**Account user name (must be a valid email address)**

| oeldemonstration+pb@gmail.com |

*User name "oeldemonstration+pb@gmail.com" is not available.*
Provider Portal Returning User

Log on Process

Provider Portal users who have already created a user account can log on from the Provider Services welcome page by entering the user name and password created during the account process. Click the Log On button to continue.

Password Recovery

If the Provider Portal user cannot remember the password, the user can click the Forgot my password link.

Clicking the Forgot my password link will display the following page:
The Provider Portal user must know the email address used for the account. Once the Provider Portal user enters an email address and clicks the **Continue** button, the following page will display:

![Forgot Password Confirmation](image)

The Provider Portal user should then access the email account used for the account and find the email sent by **DONOTREPLY@oel.myflorida.com**.

![Email from OEL Provider Portal](image)

You are receiving this message because you or someone else from this email address requested a new Provider Portal password. Please disregard this email if you did not request a new password.

To reset your password, you must complete the following steps:

1. Please reset your password by clicking here.
2. Enter your user name—it must be the email address you registered for a provider account with.
3. Enter in your new password.
4. Confirm your new password.
5. Click the Reset Password button. A Reset Password Confirmation screen will display if the logon was successful.
6. Click the Continue button. The Provider Services Login page displays and you are now ready to sign in with the new password.

*Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early Learning Coalition at the number listed above.*

Once the Provider Portal user clicks the **here** link, the following page will display:
The Provider Portal user must enter the user name (email address), new password and confirm the new password. After entering the required fields, click the Reset Password button to continue.

If the Provider Portal user successfully changes the password, the following page will display:

```
Reset Password Confirmation

The password for your account was successfully reset.
Please click Continue to proceed to the login page.

Continue
```

Change Password Process
A Provider Portal user can change the password at any point by clicking the Change my password link.

Clicking the Change my password link will display the following page:
The Provider Portal user must enter the User Name (email address), current password, new password and confirm the new password. After entering the required fields, click the Change Password button to continue.

If the Provider Portal user successfully changes the password, the following page will display:

Password Change Completed

The password for your account was successfully changed.
Please click Continue to proceed to the login page.

Continue
After logging on to the Provider Portal, the following page will display:

Update Provider Portal User Account Information

Provider Portal users can update their user information – name and phone number – associated with their email address. If the name associated with an email address is blank, the user can add the first and last name. If a name associated with a standardized email address (e.g. Info@JimsHouseofSmarties.com) needs to be changed due to a director or other staff leaving, the first and last name can be changed as long as another user has access to that Provider Portal account. If no one has access to the Provider Portal account, contact your local early learning coalition to submit a ticket to the DEL Service Desk.

Click on the gear icon.

The following will display. Click the **Account Information** button.
Enter the additional information and click **Save**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Jim</td>
</tr>
<tr>
<td>Middle Name</td>
<td>Enter Middle Name</td>
</tr>
<tr>
<td>Last Name</td>
<td>Ledbetter</td>
</tr>
<tr>
<td>Suffix</td>
<td></td>
</tr>
<tr>
<td>Phone Number</td>
<td>(850) 717-5607</td>
</tr>
</tbody>
</table>

Please update your account details to continue.
Multiple Sites
If the Provider Portal user registered a provider site that shares a taxpayer identification number with multiple sites, all of the sites with a shared taxpayer identification number will appear in a dropdown list for that Business Administrator.

Manage Sites
Providers with multiple site locations can use this feature to manage additional sites. Click the Manage All Sites link to add new provider sites. Additional sites can only be added if the sites share the same taxpayer identification number. This function will only be needed if the provider site is not found in the DEL database. Sites that share the same taxpayer identification number will automatically be assigned to the Business Administrator who registered the first provider site with the same taxpayer identification number.
After clicking the **Add Site** button, the following message will display:

**Add New Site**

To add a new site for your business, first type the license, registration, or exemption number of the new site, and then click Verify License to verify that the license number is available for use with the system.

*License/Registration/Exemption number, or EXEMPT*  
Verify License

If the new provider site matches, the location information will be pre-populated.
If the new provider site does not match, the location information must be entered by the Provider Portal user.
After clicking the **Register** button, the following message may display:

![Address Verification](image)

**USPS standardized address is 250 MARRIOTT DR TALLAHASSEE FL 32399-6573**

Would you like to use this address instead of entered address?

Click the **Yes** button to accept the standardized United States Postal Service address. Click the **No** button to go back to the previous screen to re-enter the address information.

**Manage Users**

Click the **Manage All Users** link to edit, add, and inactivate provider site users.
To edit the role of a Provider Portal user, click the **Edit** button.

**Provider User Roles:**

- **Business Administrator** – Able to edit the provider profile and principal business information that is shared among associated provider sites; able to add provider sites and users; submit profiles and profile updates; and create contracts. This role would typically be assigned to an owner.
- **Site Administrator** – Able to edit the provider profile associated to their site add provider users for a site but cannot create a new site. This role would typically be assigned to a principal or director.
- **User** – Able to perform administrative tasks based on permissions granted by the Business Administrator or Site Administrator. This role would typically be assigned to teachers and aides.

After changing the role, click the **Save** button to continue.
Adding a User

To add a user, click the Add User button.
In the user name field, the Provider Portal user will enter the email address of the new user. If the user already has an account in the Provider Portal, the user role must be selected. Click the **Save** button to continue.

**Add New User**

To add a new user to your site, first type the user name (email address) of the new user, and then click Check User Name to see if the user is already registered with the system.

User name

oeldemonstration+5@gmail.com

Check User Name

The specified user account already exists in the system, so no further account information is needed. Select the role and permissions for the new user, and then click Save.

Role

- Business Administrator
- Site Administrator
- User

Save Cancel

In the user name field, the Provider Portal user will enter the email address of the new user. If the user does not exist in the system, the user’s information and role must be entered. Click the **Save** button to continue.
Once the new user has been added, an email will be sent to the new user by DONOTREPLY@oel.myflorida.com.

Hello Jamie Ledbetter,

You are receiving this message because you have been given permission to access Jim’s House of Learning 2 with your user account in Florida’s statewide early learning Provider Portal.

You may now log on to the Provider Portal with your user name and password to get started.

If you do not have your current user name or password, contact Jim Ledbetter at veldemonstration+3@gmail.com for your log in information.

ELC of the Big Bend Region
(904) 394.5050
http://www.elcbigband.org/

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early Learning Coalition at the number listed above.

The User role has a set of permissions that can be individualized for each User. Each option is unchecked by default and must be checked to add to the User. Click the Save button to continue.

Edit User Permissions
Adding a Business Administrator to Multiple Sites

To add a Business administrator to multiple provider sites, click the **Add User** button in the “Manage Multiple Providers” section.

**NOTE:** “Manage Multiple Providers” is only available to existing Provider Portal accounts with a Business Administrator role.

![Manage All Users](image)

In the user name field, enter an email address for the new Business Administrator account. Click the **Check User Name** button.

If the email address does not exist in the system, the Password and Name fields must be filled to create a Provider Portal Account.

![Add New User](image)
Click the **Select Providers** dropdown arrow.

**NOTE:** The Role dropdown only displays Business Administrator and cannot be changed.

Select the provider sites where the user will have a Business Administrator role, then click the **Save** button.

The **Add User Confirmation** message will pop up verifying account access for the provider site.
Inactivating a User

To inactivate a user, which will remove the user from the site, click the **Inactivate** button.

If the Provider Portal user discovers that an email address has an error after it has been entered, the user can add the correct email address by clicking the **Add User** button, entering the required information, and then click the **Save** button. Then, the user will click the **Inactive** button for the email address which has the incorrect email address. For example, from the above Manage All Users screen, if the Business Administrator’s email address was incorrectly entered as oeldemonstation@gamaial.com, the process would be to click the **Add User** button and create oeldemonstation+3@gmail.com, click **Save**, and then click **Inactivate** for oeldemonstation@gamaial.com. It is important to create the correct email address first before inactivating the incorrect email address.
Provider Cost of Care Estimate

The Provider Cost of Care Estimate pop-up message will appear for all providers that have an incomplete or Active 2022-2023 provider profile in EFSM. The providers do not have to have School Readiness or VPK contracts to complete the cost of care estimate.

The pop-up message will appear on the provider dashboard after logging in and will continue to pop up until the provider completes and submits the estimate.

May 31, 2023 is the last day the provider will be able to submit the estimate. The pop-up message will not appear after the deadline.

Click the **Proceed to Provider Cost of Estimate** button in the pop-up message OR click the link in the Common Tasks list.
The link will remain in the Common Tasks list after the May 31, 2023 deadline to allow the provider to view the data that was submitted, but the form will not be editable. The link will not display after May 31st if the estimate is not submitted.

**NOTE:**

- The provider cost of care estimate may be saved at any time by pressing the **Save for Later** button at the bottom of the application.
- The **Save for Later** button will return you to the provider dashboard where they can access the cost estimate at a future time by clicking the Provider Cost of Care Estimate link located under Provider Cost of Care Estimate on the left of the provider dashboard.
- All fields are required to be completed for the **Submit** button to appear.
- All applications must be submitted no later than May 31, 2023.

The Child Care Provider Cost of Care Estimate will appear in a **New** status. The status will remain **New** until the provider saves at least one answer.
<table>
<thead>
<tr>
<th>Estimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. How much has your program(s) spent on materials and curriculum from July 1, 2022, through June 30, 2023? These costs could include but are not limited to the following items:</td>
</tr>
<tr>
<td>- Educational materials - includes books, toys, puppets, wall posters, manipulatives, consumable items like paint, paper, crayons</td>
</tr>
<tr>
<td>- Curriculum - all preprint and electronic textbooks, instructional materials, lesson plans, teacher guides, workbooks, tests, and other curriculum-related materials, annual subscriptions, and all supplemental instructional materials</td>
</tr>
<tr>
<td>2. How much has your program(s) spent on food/food preparation from July 1, 2022, through June 30, 2023? These costs include the total amount spent, including those expenses that may have been reimbursed by the Florida Department of Health's Child Care Food Program or any other reimbursements received. These costs could include but are not limited to the following items:</td>
</tr>
<tr>
<td>- Meals and snacks, including drinks, formula</td>
</tr>
<tr>
<td>- Kitchen supplies</td>
</tr>
<tr>
<td>- Consumables such as dish soap, containers, foil, cling wrap, etc.</td>
</tr>
<tr>
<td>3. How much has your program(s) spent on maintenance costs from July 1, 2022, through June 30, 2023? These costs include all expenses associated with keeping all buildings and equipment necessary for the safe delivery of early care and education services. Examples include, but are not limited to, the cost of the following:</td>
</tr>
<tr>
<td>- Maintenance staff or services</td>
</tr>
<tr>
<td>- Yard/ground maintenance</td>
</tr>
<tr>
<td>- Replacing or repairing furnishings, equipment, and building systems such as HVAC, electrical, and plumbing</td>
</tr>
<tr>
<td>4. How much has your program(s) spent on regulatory fees from July 1, 2022, through June 30, 2023? These costs could include but are not limited to the following items:</td>
</tr>
<tr>
<td>- Licensing</td>
</tr>
<tr>
<td>- Accreditation (for example, Gold Seal, national associations, and memberships)</td>
</tr>
<tr>
<td>5. What is your average enrollment from July 1, 2022, through June 30, 2023? To calculate average enrollment, sum the total of each month’s enrollment and divide by the total number of months used in the calculation.</td>
</tr>
<tr>
<td>For example, if you were open the entire time frame and enrollments were 12 monthly (July - December 2022) and 15 monthly (Jan - June 2023), the total enrollments would equal 72 (12 x 6) + 90 (15 x 6) = 162. Take the total enrollments and divide by total months (12) or 162/12 = 13 5 rounded up to 14.</td>
</tr>
<tr>
<td>Average Enrollment</td>
</tr>
<tr>
<td>6. How much has your program(s) spent on operational costs from July 1, 2022, through June 30, 2023? Operational costs refer to the costs incurred to maintain the day-to-day operations of your business. Examples of operational costs include but are not limited to:</td>
</tr>
<tr>
<td>- Payroll</td>
</tr>
<tr>
<td>- Benefits</td>
</tr>
<tr>
<td>- Rent or mortgage</td>
</tr>
<tr>
<td>- Facility expenses (utilities, insurance, maintenance)</td>
</tr>
<tr>
<td>- Training expenses</td>
</tr>
<tr>
<td>- Equipment and supplies</td>
</tr>
<tr>
<td>- Other costs and services</td>
</tr>
</tbody>
</table>

**Note:** The total operational cost reported in item #6 will be divided by average enrollment reported in item #5 to calculate a per-child operational cost from July 1, 2022, through June 30, 2023.
After clicking the **Save For Later** button, a confirmation pop-up message will appear. Click **Yes** and the page will refresh displaying the Incomplete status as well as the datetime stamp and user that saved the answer(s).

Once an answer is saved, the status changes to **Incomplete**.

**NOTE:** Negative numbers (-1.00) and letters will not save.
When all the questions are answered, the **Submit Estimate** button will appear at the bottom of the page.

After clicking the **Submit Estimate** button, a confirmation pop-up message appears. Click **Yes**.

When the submission is complete, a Success pop-up message. Click **OK**.

The page reloads and the status is **Complete**.

If the provider has submitted the estimate and changes need to be made after the submission, the questions and button on the page will remain active until June 1, 2023 of this year. The previous answers are stored in the database.
The Broadcast Messages section of the Provider Dashboard will display all messages sent by the local early learning coalition to all providers in the coalition service area. Click the message title to see the full text of the message.

The Coalition Messages section of the Provider Dashboard displays messages sent by the local early learning coalition to a specific provider. This is a one-way communication; the provider cannot email the coalition directly from the portal. Click the message title to see the full text of the message.
Frequently Used Links

The Frequently Used Links section of the Provider Dashboard has links to web pages with information about statewide provider requirements, training and services.

Completing the Provider Profile

After registering as a provider, the next step is to complete the Provider Profile.

Request Assistance

If a Provider Portal user needs assistance filling out any information in the Provider Profile, click the Request Assistance button.
Then, complete the field, briefly describing the need for assistance. Click the **Submit** button to send the request.

After clicking **Submit**, the following message will display:

The Provider Portal user will not be able to edit the profile once the request for assistance is submitted; however, coalition staff will be able to edit information in a profile while providing assistance to a Provider Portal user.
The request for assistance can be cancelled by the Provider Portal user by clicking the **Cancel Assistance Request** button.

If a Provider Portal user cancels the assistance request, the following message will display and the user will complete the field, briefly describing the reason for cancelling the request. Click the **Submit** button to continue.

After cancelling the request, the following message will display:
Business

The Business Information page collects business information about the provider, including business name and address information, and it is shared among additional sites (if any). Only a Business Administrator may edit the information on this page.

**NOTE:** This information was previously captured in the Business tab of the provider profile. Although the Business Information page is now separated from the provider profile, it must be completed before the profile may be submitted.

Tool tips, indicated by the symbol, are available to provide useful information to Provider Portal users about specific terms in the Provider Profile. Click the to see the message.

To complete the Business Info page, click the **Business** dropdown menu from the Provider Dashboard.

Then, click **Business Info**.
### Business Information

1. **Business Name Associated with Your Taxpayer Identification Number**
   - Jim’s House of Learning 3

2. **Taxpayer Identification Number**
   - 88888888

3. **Owner Information**
   - **Owner Name**
     - Jim Lodblatt
   - **Owner Email Address**
     - fake@foo.com
   - **Owner Telephone Number**
     - (555) 555-5555

4. **Owner’s Designee or Contact Person Information**
   - **Designee/Contact Name**
     - Jim Lodblatt
   - **Designee/Contact Email Address**
     - fake@foo.com
   - **Designee/Contact Telephone Number**
     - (555) 555-5555

5. **Business Ownership Type**
   - Corporation

6. **Physical Address Information**
   - **Address Line 1**
     - 250 MARRIOTT DR
   - **City**
     - TALLAHASSEE
   - **State**
     - FL
   - **Zip Code**
     - 32301

7. **Mailing Address Information**
   - **Address Line 1**
     - 250 MARRIOTT DR
   - **City**
     - TALLAHASSEE
   - **State**
     - FL
   - **Zip Code**
     - 32301

8. **Payment Mailing Address Information**
   - **Address Line 1**
     - 250 MARRIOTT DR
   - **City**
     - TALLAHASSEE
   - **State**
     - FL
   - **Zip Code**
     - 32301

---

**[Save]**
Profile

A Provider Portal user must fill out all information in each tab, and click the Next button to continue filling out the provider profile information. Click the Back button to return to the previous tab.

Tool tips, indicated by the symbol, are available to provide useful information to Provider Portal users about specific terms in the Provider Profile. Click the to see the message.

To complete the Provider Profile, click the Profile dropdown menu from the Provider Dashboard.

Then, click Provider Profile.
Yellow Warning Symbols

Yellow warning symbols will appear on certain fields on the following tabs: General, Facility, Services, Curriculum, Staffing & Capacity, and Documents.

If the Provider Portal user hovers over the yellow warning symbol, the following message will display.

If a change is made, the coalition will review the change and change the profile status to **Incomplete** to allow the Provider Portal user to re-submit the VPK-APP. The user will receive the following email from **DONOTREPLY@OEL.myflorida.com**.

---

From: OEL.SysTest@oel.myflorida.com
Date: Wed, Aug 16, 2017 at 12:08 PM
Subject: Signature Required - VPK Provider Application Updated
To: alannah77@gmail.com
Cc: MB@avantage.com

Hello,

The VPK Provider Application (VPK 10, 11A, 11B) forms have been updated for Maggie Mae Daycare. Your review and signature is required. Please log on the Provider Portal and go to the Contracts menu, and choose Manage Contracts. On this page, locate your VPK-APP and click Edit. Review the VPK Provider Application information and submit your signature on the Certify and Submit tab.

Please review and submit your signature as quickly as possible.

Thank you,

ELC of the Big Bend Region
(850) 973-4010
http://www.elcbigbend.org/

Please do not reply to this message. Replies to this message are routed to an unmaintained mailbox. If you have questions, please contact your early learning coalition.
### Step 1 – General

The **General tab** collects basic information about the provider, including provider types and whether or not there is interest in contracting with the early learning coalition to provide School Readiness or Voluntary Prekindergarten (VPK) Education services.

<table>
<thead>
<tr>
<th>Question</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do you want to have your program referred to families seeking child care listings?</td>
<td>Yes</td>
</tr>
<tr>
<td>2. Do you want to complete a contract to participate in the School Readiness Program?</td>
<td>Yes</td>
</tr>
<tr>
<td>2.1 Have you completed the Health &amp; Safety Inspection by Department of Children and Families?</td>
<td>Yes</td>
</tr>
<tr>
<td>3. Do you want to complete a contract to participate in the Voluntary Prekindergarten (VPK) Education Program?</td>
<td>Yes</td>
</tr>
<tr>
<td>4. Do you want to complete a contract to receive local funding?</td>
<td>Yes</td>
</tr>
<tr>
<td>5. Are you a Gold Seal provider?</td>
<td>Yes</td>
</tr>
<tr>
<td>5.1 Gold Seal Accreditation (select one)</td>
<td>Gold Seal for Birth to 5</td>
</tr>
<tr>
<td>6. Are you an accredited provider?</td>
<td>Yes</td>
</tr>
<tr>
<td>6.1 Accreditation (select all that apply)</td>
<td>OTHER</td>
</tr>
</tbody>
</table>
Step 2 – Facility

The Facility tab collects contact information for the provider. The Provider Portal user is required to enter contact information for staff responsible for different aspects of the business. If the staff person is an Authorized Contract Representative or VPK Authorized Contract Representative, click the checkbox below each section (Director, VPK Director, etc.).

All VPK Providers: Each child enrolled in VPK must be assessed under the Coordinated Screening and Progress Monitoring Program (CSPM), known as the Florida Assessment of Student Thinking (FAST) using Star Early Literacy. Each provider must designate a primary contact to receive information regarding participation. A CSPM secondary contact is optional.

- CSPM primary and secondary contacts should not be the same.
- If both CSPM primary and secondary contacts are populated, the system compares the email addresses and will display an error if the primary and secondary contact emails are the same.

<table>
<thead>
<tr>
<th>Facility</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Doing Business as Name (DBA)</td>
</tr>
<tr>
<td>Ventura Day School</td>
</tr>
<tr>
<td>2. Contact</td>
</tr>
<tr>
<td>Telephone: (850) 555-5555</td>
</tr>
<tr>
<td>Phone Type: Land Line</td>
</tr>
<tr>
<td>Fax Number</td>
</tr>
<tr>
<td>Email Address: <a href="mailto:jennifer.ventura.prod+testprovidergeneralcontact@gmail.com">jennifer.ventura.prod+testprovidergeneralcontact@gmail.com</a></td>
</tr>
<tr>
<td>3. Physical Address of Facility</td>
</tr>
<tr>
<td>Address Line 1</td>
</tr>
<tr>
<td>Address Line 2</td>
</tr>
<tr>
<td>City: Tallahassee</td>
</tr>
<tr>
<td>State: Florida</td>
</tr>
<tr>
<td>Zip Code: 32311</td>
</tr>
<tr>
<td>County: KREPS ISLAND</td>
</tr>
<tr>
<td>4. Director</td>
</tr>
<tr>
<td>Director Name</td>
</tr>
<tr>
<td>Director Telephone Number: (850) 555-5555</td>
</tr>
<tr>
<td>Director Email: <a href="mailto:jennifer.ventura.prod+testprovider.director@gmail.com">jennifer.ventura.prod+testprovider.director@gmail.com</a></td>
</tr>
<tr>
<td>Director Phone Type: Land Line</td>
</tr>
</tbody>
</table>
5. **VPK Director**

- **VPK Director Information is the same as the Director Information.**
  - **VPK Director Name**
    - [Redacted]
  - **VPK Director Telephone Number**
    - (850) 555-5555
  - **VPK Director Phone Type**
    - [Select Type]

- **Is VPK Authorized Contract Rep**

5.1. **VPK Coordinated Screening and Progress Monitoring (CSPM) Contact**

- **CSPM Primary Contact Information is the same as (select one):**
  - [Select Option]
  - **CSPM Primary Contact Name**
    - [Redacted]
  - **CSPM Primary Contact Telephone Number**
    - [Redacted]
  - **CSPM Primary Contact Phone Type**
    - [Select Type]

- **CSPM Secondary Contact Information is the same as (select one):**
  - [Select Option]
  - **CSPM Secondary Contact Name**
    - [Redacted]
  - **CSPM Secondary Contact Telephone Number**
    - [Redacted]
  - **CSPM Secondary Contact Phone Type**
    - [Select Type]
NOTE: If the childcare program is certified by the U.S. Department of Defense and is operating on a military installation, an additional question will display after question 8, but only if the provider meets one of the following conditions:

<table>
<thead>
<tr>
<th>5. Legal Status</th>
<th>7. Exemption Reason</th>
<th>8. Provider Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licensed</td>
<td>N/A</td>
<td>Center</td>
</tr>
<tr>
<td>Licensed</td>
<td>N/A</td>
<td>Family Child Care Home</td>
</tr>
<tr>
<td>Licensed</td>
<td>N/A</td>
<td>Large Family Child Care Home</td>
</tr>
<tr>
<td>Registered</td>
<td>N/A</td>
<td>Family Child Care Home</td>
</tr>
<tr>
<td>Exempt</td>
<td>Military</td>
<td>Center</td>
</tr>
<tr>
<td>Exempt</td>
<td>Military</td>
<td>Family Child Care Home</td>
</tr>
<tr>
<td>Exempt</td>
<td>Military</td>
<td>Large Family Child Care Home</td>
</tr>
</tbody>
</table>

The additional question asks, “Are you an accredited childcare program certified by the United States Department of Defense AND operating on a military installation?” The Provider Portal User can select Yes or No. If the user selects Yes, a pop-up message will appear asking the user to verify their selection. After submitting the profile, this selection cannot be changed.
When the **Add New Contact** button is clicked, the Provider Portal user can create additional provider contacts for the profile.
Step 3 – Services

The Services tab collects information on the ages of the children in provider care, as well as different provider services.

<table>
<thead>
<tr>
<th>Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Age of Children for which Care is Provided</td>
</tr>
<tr>
<td>Minimum Age**</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2. Program Offered (select all that apply) ▲</td>
</tr>
<tr>
<td>Before School</td>
</tr>
<tr>
<td>3. About My Program (select all that apply) ▲</td>
</tr>
<tr>
<td>Music lessons</td>
</tr>
<tr>
<td>4. Languages Spoken by Staff (select all that apply) ▲</td>
</tr>
<tr>
<td>English</td>
</tr>
<tr>
<td>5. Other Spoken Languages</td>
</tr>
<tr>
<td>6. Meals (select all that apply) ▲</td>
</tr>
<tr>
<td>Monday Snack</td>
</tr>
<tr>
<td>7. Do you provide transportation services? **</td>
</tr>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>8. Transportation (select all that apply)</td>
</tr>
<tr>
<td>Transportation to/from local school</td>
</tr>
<tr>
<td>8.1 Transportation to/from Local School</td>
</tr>
<tr>
<td>School Name</td>
</tr>
<tr>
<td>Mickey Mouse</td>
</tr>
<tr>
<td>9. Do you currently implement a character development program? **</td>
</tr>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>9.1 Description of Character Development Program (250 characters max)</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>10. Is your program equipped to care for children with special needs? **</td>
</tr>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>11. Is your facility wheelchair-accessible? **</td>
</tr>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>12. Does your program/facility offer therapeutic services to children? **</td>
</tr>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>13. Do you participate in a quality rating system? **</td>
</tr>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>14. Affiliation - Not for Profit **</td>
</tr>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>15. Military Child Care **</td>
</tr>
<tr>
<td>Yes</td>
</tr>
</tbody>
</table>
Step 4 – Curriculum
The Curriculum tab collects information about the provider’s curriculum. A provider may choose multiple curricula from the list. If the provider is a school readiness provider, an approved curriculum must be chosen. If no approved curricula are being used by the provider, the Provider Portal user should select “Other.” If a provider does not see their curricula listed, choose “Other” as the curriculum.

Step 5 – Fees & Discounts
The Fees & Discounts tab collects information about fees the provider assesses the parent. The Provider Portal user should enter all applicable fees. All amount fields must have either a dollar amount or zero entered. If a fee is not applicable, the amount entered must be “0.” If there are no family discounts offered, the selection must be “None.”
Step 6 – Hours of Operation

The Hours of Operation tab collects information on the type of schedules offered for care. The Provider Portal user must click the checkbox next to the desired day of the week before inputting hours of operation for that day. The default hours of operation for each day are 6:00 a.m.– 6:00 p.m. An Enhanced Schedule is available.

Facility Hours of Operation

1. Enhanced Schedule (select all that apply)

- 24-hour Care
- Drop in Care
- Early/Extended Care
- Emergency/Temporary
- Evening
- Full Year
- Full-time
- Overnight
- Part time

<table>
<thead>
<tr>
<th>Day</th>
<th>Hours</th>
<th>Open</th>
<th>Close</th>
<th>Total Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tuesday</td>
<td>24</td>
<td>12:00 AM</td>
<td>11:59 PM</td>
<td>23.98</td>
</tr>
<tr>
<td>Wednesday</td>
<td>24</td>
<td>12:00 AM</td>
<td>11:45 PM</td>
<td>23.75</td>
</tr>
<tr>
<td>Thursday</td>
<td></td>
<td>12:00 AM</td>
<td>12:00 AM</td>
<td>0</td>
</tr>
<tr>
<td>Friday</td>
<td></td>
<td>12:00 AM</td>
<td>12:00 AM</td>
<td>0</td>
</tr>
<tr>
<td>Saturday</td>
<td></td>
<td>12:00 AM</td>
<td>12:00 AM</td>
<td>0</td>
</tr>
</tbody>
</table>
Step 7 – Staffing & Capacity

The Staffing & Capacity tab collects information on how many children the facility will or can care for. These questions are asked by age group. For each care level, the Provider Portal user should enter the highest number of teachers and children for all classrooms for each care level. This tab does not calculate staff-to-child ratios, but stores staffing and capacity numbers for local early learning coalition review.

**Staff-to-child Ratio** is the number of children that an individual teacher is responsible for. To reflect the actual ratio, the “Teachers in Classroom” column should always be 1. For example, if you have 2 teachers with one class of 20, you should list 1 “Teacher in Classroom” with 10 “Children in Classroom” and a “Group Size” of 20. If you follow the state mandated ratios for a center or facility, please see the example below. You can omit the age groups you do not serve.

**Group Size** is the maximum number of children, by age, that can be in a single classroom at any given time. If you follow the state mandated group sizes for a center or facility, please see the example below. You can omit the age groups you do not serve.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>Teachers in Classroom</th>
<th>Children in Classroom</th>
<th>Group Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>12 &lt; 24 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>24 &lt; 36 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>36 &lt; 48 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>48 &lt; 60 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>60 &lt; 72 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>In School</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Training/Education Type</td>
<td>Number of Staff</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-----------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FCCH 36 HOUR TRAINING</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>48/46 HR INTRO CHILD CARE</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AAAS NONCHILD RELATED</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AAAS EARLY CHILDHOOD OR RELATED FIELD</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECTOR CREDENTIAL ADV</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECTOR CREDENTIAL LEVEL 1</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECTOR CREDENTIAL LEVEL 2</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BASIS NONCHILD RELATED</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BA EARLY CHILDHOOD OR RELATED FIELD</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BEHAVIOR OBSERVATION</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECTOR (NON VPK)</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GED/HIGH SCHOOL</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EARLY (EMERGENT) LITERACY</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FOCPO/ECPO/CCAC/IDAE</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MA DEGREE EARLY CHILDHOOD</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MA NONCHILD RELATED</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NATE EARLY CHILDHOOD CERT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCHOOL AUC CREDENTIAL</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VPK DIRECTOR CREDENTIAL</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OTHER-LIST</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Example: Child Care Center 1
This example uses the state mandated minimum staff-to-child ratios and maximum group sizes permitted for centers.

Example: Child Care Center 2
This example uses more stringent staff-to-child ratios and group sizes that are smaller than the state mandate for centers.

For more information on staff-to-child ratios and group sizes for facilities, please visit the School Readiness Health and Safety Standards Handbook.
Example: Family Child Care Homes 1

A family day care home is allowed to provide care for one of the following groups of children, which includes household children under 13 years of age. Below are examples of how to fill out this table using the state mandated minimum ratios.

**The group size column should never exceed 10 for a family child care home.**

This example uses the maximum of four children from birth to 12 months of age.

![Staffing and Capacity Table](image)

Example: Family Child Care Homes 2

This example uses the maximum of three children from birth to 12 months of age, and other children, for a maximum total of six children.

![Staffing and Capacity Table](image)
Example: Family Child Care Homes 3
This example uses the maximum of six preschool children if all are older than 12 months of age.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>Teachers in Classroom</th>
<th>Children in Classroom</th>
<th>Group Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>12 &lt; 24 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>24 &lt; 36 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>36 &lt; 48 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>48 &lt; 60 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>60 &lt; 72 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>In School</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Example: Family Child Care Homes 4
This example uses the maximum of 10 children if no more than 5 are preschool age and, of those 5, no more than 2 are under 12 months of age.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>Teachers in Classroom</th>
<th>Children in Classroom</th>
<th>Group Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>12 &lt; 24 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>24 &lt; 36 Months</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>36 &lt; 48 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>48 &lt; 60 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>60 &lt; 72 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>In School</td>
<td>1</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Example: Large Family Child Care Homes 1
A large family child care home is allowed to provide care for one of the following groups of children, which includes household children under 13 years of age.

**The group size column should never exceed 12 for a large family child care home.**

This example uses the maximum of 8 children from birth to 24 months of age.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>1. Staff-to-Child Ratio in Your Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>Teachers in Classroom: 1 : Children in Classroom: 3 : Group Size: 3</td>
</tr>
<tr>
<td>12 &lt; 24 Months</td>
<td>1 : 5 : 5</td>
</tr>
<tr>
<td>24 &lt; 36 Months</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>36 &lt; 48 Months</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>48 &lt; 60 Months</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>60 &lt; 72 Months</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>In School</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0 : 0 : 0</td>
</tr>
</tbody>
</table>

Example: Large Family Child Care Homes 2
This example uses the maximum of 12 children, with no more than 4 children under 24 months of age.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>1. Staff-to-Child Ratio in Your Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>Teachers in Classroom: 1 : Children in Classroom: 1 : Group Size: 1</td>
</tr>
<tr>
<td>12 &lt; 24 Months</td>
<td>1 : 1 : 1</td>
</tr>
<tr>
<td>24 &lt; 36 Months</td>
<td>1 : 2 : 2</td>
</tr>
<tr>
<td>36 &lt; 48 Months</td>
<td>1 : 4 : 4</td>
</tr>
<tr>
<td>48 &lt; 60 Months</td>
<td>1 : 4 : 4</td>
</tr>
<tr>
<td>60 &lt; 72 Months</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>In School</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0 : 0 : 0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0 : 0 : 0</td>
</tr>
</tbody>
</table>

Step 8 – Private Pay Rates

The Private Pay Rates tab collects information on the provider’s private pay rate based on unit of care and care level. The Provider Portal user must enter in the private pay rates for each “Unit of Care” and “Care Level” offered by the provider. Shaded cells do not permit entry. If care is not provided for that Unit of Care and Care Level, no entry is needed.

Providers that indicate they want to complete a contract to participate in the school readiness program on the General tab will also have a section on the Private Pay Rates tab to enter the Daily Rates for the School Readiness Program. The Provider Portal user may edit the $0.00 amount for each “Unit of Care” and “Care Level” offered by the provider or click on the SR Daily Rate Helper button. The Helper button will automatically calculate the rates based on the Full Time Monthly Rates or Full Time Weekly Rates, and the Part Time Weekly Rates entered in the Private Pay Rates section. The rates are also editable after calculation. These rates will be utilized in the contracting process if the provider enters into a School Readiness contract with an early learning coalition.

**NOTE:** With Release 3.5, School Readiness providers must now answer a question regarding the family’s responsibility to pay the differential between the Approved Reimbursement Rate and the Private Pay Rate.
Step 9 – Closures Calendar

The Closures Calendar tab collects information on any days the provider will be closed. The Provider Portal user will select all closure days for the provider. Once selected, the date will change from white to blue. The local early learning coalition may define reimbursable holidays for the School Readiness program, which will be shaded gray. When a provider closure date and a coalition-defined reimbursable holiday are the same, the date will be shaded dark blue. A Provider Portal user does not need to include Saturdays and Sundays on the Closures Calendar if services are not provided on those days.

NOTE: Actual reimbursable holidays will be selected during the contracting process if the provider enters into a School Readiness contract with an early learning coalition.
Step 10 – Documents

The Documents tab allows the Provider Portal user to upload documents for the local early learning coalition to review. Based on provider answers in the provider profile, the Documents tab will display types of documents that may be uploaded to support a contract to provide School Readiness or VPK services. Users may enter up to five documents for each document type. Documents uploaded in this tab will also populate in the Document Library and will be utilized during the contracting process.

<table>
<thead>
<tr>
<th>Supporting Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Certificate of Accreditation</strong></td>
</tr>
<tr>
<td>Upload Document...</td>
</tr>
<tr>
<td><strong>Certificate of Licensure</strong></td>
</tr>
<tr>
<td>Upload Document...</td>
</tr>
<tr>
<td><strong>Private Child Care Pay Rates</strong></td>
</tr>
<tr>
<td>Upload Document...</td>
</tr>
<tr>
<td><strong>IRS Form W-9</strong></td>
</tr>
<tr>
<td>Upload Document...</td>
</tr>
</tbody>
</table>
Step 11 – Review

After reviewing the information for each section, the Provider Portal user must click the **Next** button to continue.

Click the **+** to expand and the **−** to collapse each section below. Click the **Button** to navigate back to that section.

---

<table>
<thead>
<tr>
<th>Section</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do you have an approved center in your community?</td>
<td>Yes</td>
</tr>
<tr>
<td>2. Do you want to complete a contract?</td>
<td>Yes</td>
</tr>
<tr>
<td>3. Have you completed the health &amp; safety inspections by the Division of Children and Families?</td>
<td>Yes</td>
</tr>
<tr>
<td>4. Are you a Child Care provider?</td>
<td>Yes</td>
</tr>
<tr>
<td>5. Are you a certified provider?</td>
<td>Yes</td>
</tr>
<tr>
<td>6. Are you an accredited provider?</td>
<td>Yes</td>
</tr>
<tr>
<td>7. Are you an accredited preschool?</td>
<td>Yes</td>
</tr>
<tr>
<td>8. Are you an accredited preschool?</td>
<td>Yes</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Closures Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>7/4/2017</td>
</tr>
<tr>
<td>8/22/2017</td>
</tr>
<tr>
<td>9/4/2017</td>
</tr>
<tr>
<td>8/22/2017</td>
</tr>
<tr>
<td>8/10/2017</td>
</tr>
<tr>
<td>8/11/2017</td>
</tr>
<tr>
<td>8/22/2017</td>
</tr>
</tbody>
</table>

---

Back

Next
Step 12 – Sign and Certify

To submit the Provider Profile, the Full Name must exactly match (and is case-sensitive) the name entered on the Manage Users page. The Provider Portal user must then check the “Check box to certify by electronic signature” check box and click the Submit button.

Once the Provider Portal user submits the Provider Profile, the following page will display:

You have successfully completed and submitted your Provider Profile.

Your early learning coalition will process your profile.

Please check your email for important information about your profile.

You can click on the button below to return to the home page.

The Provider Portal user should then find the email sent by DONOTREPLY@oel.myflorida.com.
Managing a Profile as a Provider Portal User

Provider Dashboard

On January 1 of each program year, a button will appear next to the current program year that will allow the Provider Portal user to migrate all profile information from the current program year to the next program year (except Closures Calendar dates). To migrate profile information to the next program year, the Provider Portal user will click the Create 2019 button. In this example, the provider is migrating profile information from the 2018 – 2019 program year to the 2019 – 2020 program year. All information from the 2018-2019 profile will migrate to the 2019-2020 profile, with the exception of the Closures Calendar. The provider can also skip a profile year and still be able to create a profile for the current year. For example, the provider had a 2017-2018 profile, but skipped the 2018-2019 profile. In order to create a 2019-2020 profile, the provider will go to the 2017-2018 profile, click the Create 2018 button, then go to the 2018-2019 profile, and click the Create 2019 button. The skipped profile 2018-2019 can remain Incomplete.

After a provider is active, a Provider Portal User can edit the Provider Profile, by clicking the Profile dropdown menu and then clicking the Provider Profile button.

Provider Portal users can manage School Readiness and VPK contracts from the Provider Dashboard.
Provider Portal users can manage School Readiness and VPK enrollments from the Provider Dashboard.

Provider Portal users can manage School Readiness and VPK attendance, as well as view reimbursement details for paid attendance rosters, SR Reimbursement Rates, and Temporary Closures, from the Provider Dashboard.

Provider Portal users can click the Documents dropdown menu to access the Document Library Management function and view and upload additional documents for coalition review.
Managing Contracts

Provider Portal users can view contract statuses and edit/download contracts through the Manage Contracts function.

<table>
<thead>
<tr>
<th>Contract ID</th>
<th>Type of Contract</th>
<th>Contract Name</th>
<th>Coalition</th>
<th>Status</th>
<th>Last Updated</th>
<th>Action</th>
<th>View Contract</th>
<th>Start Date</th>
<th>End Date</th>
<th>Termination Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>VPK-APF</td>
<td>VPK 10, 11A, 11D</td>
<td>ELC of Palm Beach</td>
<td>Coalition Reviewing</td>
<td>06/20/2017</td>
<td>Download</td>
<td>View</td>
<td>07/01/2017</td>
<td>06/30/2018</td>
<td></td>
</tr>
<tr>
<td>139</td>
<td>VPK</td>
<td>ELC-VPK 20</td>
<td>ELC of the Big Bend Region</td>
<td>Certified</td>
<td>03/18/2017</td>
<td>Download</td>
<td>View</td>
<td>07/01/2017</td>
<td>06/30/2018</td>
<td></td>
</tr>
<tr>
<td>156</td>
<td>VPK</td>
<td>ELC-VPK 20</td>
<td>ELC of the Big Bend Region</td>
<td>Terminated</td>
<td>05/20/2017</td>
<td>Download</td>
<td>View</td>
<td>07/01/2017</td>
<td>06/30/2018</td>
<td></td>
</tr>
<tr>
<td>157</td>
<td>VPK</td>
<td>ELC-VPK 20</td>
<td>ELC of the Big Bend Region</td>
<td>Terminated</td>
<td>06/20/2017</td>
<td>Download</td>
<td>View</td>
<td>07/01/2017</td>
<td>03/02/2019</td>
<td>06/26/2017</td>
</tr>
<tr>
<td>180</td>
<td>VPK</td>
<td>ELC-VPK 20</td>
<td>ELC of the Big Bend Region</td>
<td>Not Eligible</td>
<td>05/24/2017</td>
<td>Download</td>
<td>View</td>
<td>07/01/2017</td>
<td>06/30/2018</td>
<td></td>
</tr>
<tr>
<td>26733</td>
<td>SR</td>
<td>Contract Life</td>
<td>OEL</td>
<td>Terminated</td>
<td>04/02/2017</td>
<td>Download</td>
<td>View</td>
<td>01/10/2017</td>
<td>01/10/2019</td>
<td>04/04/2017</td>
</tr>
<tr>
<td>26731</td>
<td>BR</td>
<td>Contract Life</td>
<td>OEL</td>
<td>Certified</td>
<td>03/15/2017</td>
<td>Download</td>
<td>View</td>
<td>01/10/2017</td>
<td>01/10/2019</td>
<td>04/04/2017</td>
</tr>
<tr>
<td>26798</td>
<td>VPK-SS3</td>
<td>Contract Life</td>
<td>OEL</td>
<td>Certified</td>
<td>04/04/2017</td>
<td>Download</td>
<td>View</td>
<td>04/04/2017</td>
<td>06/30/2017</td>
<td></td>
</tr>
<tr>
<td>26804</td>
<td>VPK-SS3</td>
<td>Contract Life</td>
<td>ELC of the Big Bend Region</td>
<td>Terminated</td>
<td>06/26/2017</td>
<td>Download</td>
<td>View</td>
<td>05/18/2017</td>
<td>06/30/2017</td>
<td>04/29/2017</td>
</tr>
</tbody>
</table>
Managing Documents

Documents can be added to the Document Library for coalition review. The folder list within the Document Library is standard for all providers, but coalitions have the ability to re-name or add new folders. Documents uploaded to the Documents tab of the provider profile will also populate in the Document Library; however, documents uploaded to the Document Library will not populate in the Documents tab of the provider profile.

Viewing/Uploading Documents

To view or upload documents in a folder, the provider portal user will click the View Files or Upload New File button, respectively.
Add New File

Select a document to upload.

- Select the folder from the drop down list to which you would like to upload a file to.
- Click the Browse button to browse your documents and select the one that you want to upload to the folder.
- You may give a description to the file you are uploading.

Upload file to site:  Jim's House of Learning 2

Select Destination Folder: Contracts

Select File: Browse

Attach your document.

Click the Attach Selected Document button below to upload the selected document to your selected folder. This will upload a copy of your document and store it in the chosen folder. The upload process may take from several seconds to a minute, depending on the size of the document and the speed of your internet connection.

Attach Selected Document
Provider Portal users can move within the Document Library by clicking the Change Folder dropdown menu. Files can also be renamed within each folder by clicking the **Rename File** button.

Enter the new file name in the New File Name field and click the **Save Changes** button to continue.

Archiving Documents
Click the **Remove** button to remove a document from the profile documents screen and archive it in the appropriate Document Library Management folder.
A Frequently Asked Questions pop-up message is available for the Provider Portal user. Contact the local early learning coalition if additional help is needed.

**Frequently Asked Questions**

**How do I create a new folder?**
A: Folders can only be created by your Coalition. In case you need to add files that cannot be assigned to one of the pre-defined folders please put them in the 'Miscellaneous' folder. Call your coalition for further information.

**How do I upload files to a folder?**
A: Click 'Upload New File' button which will open a dialog box that allows you to upload a file to a folder you select.

**If I misspelled a word when naming a file, how can I correct it?**
A: Files can be renamed from the 'Folder Details' screen. Click on the 'View Files' button to navigate to the 'Folder Details' screen, here you have to click on the 'Rename File' button that would open a dialog box that allows you to select the Folder and the files within it that you wish to rename.

**Note:** You can only change the name of an existing file and not its type or extension.

**What format does a document have to be in to be uploaded?**
A: Any of the following formats are permitted: .bmp, .tiff, .pdf, .jpg, .gif, .png, .doc, .docx, .txt

**Is there a size limit on the documents to be uploaded?**
A: A file's size cannot exceed 2MB.

**Who can I contact for technical assistance?**
A: Please call your coalition office for any further assistance. [coalition map]

**How can I reduce the size of my document?**
A: To reduce the file size of a PDF, print the file using Adobe PDF as the printer, select the smallest file size option under the Default Settings menu and click OK on all open dialog boxes. The PDF is then converted to a smaller file. Upon completion, save the new file.
Provider Contracting

**NOTE:** Provider contracts are populated by information in the *Active* profile. As a result, the profile is read-only once the contract status is *Initiated*, *Incomplete*, or *Submitted*. If any changes need to be made to the *Active* profile after a contract is initiated or there is an error found in the profile once the contract is being edited (the contract status is *Incomplete*), contact your early learning coalition.

SR Contract

After the coalition has initiated an SR contract, the user will navigate to **Contracts > Manage Contracts** from the Provider Dashboard.

The Manage Contracts page displays. Click the **Edit** button for the initiated DEL-SR 20.
Provider Eligibility and Notification

After clicking the Edit button, the following page displays. Review the options in the dropdown menus and update the provider representative information, if needed.

Provider Responsibilities and Scope of Work

If the provider is eligible to participate in the contracted slots program, the provider must select if they want to participate in the program. If the contracted slots program is not applicable, the option to participate in the contracted slots program is not displayed.

If this question is displayed, make a selection, then click Next Step to continue.
Signature Authority

Providers must designate all users who are authorized to sign the SR contract for the listed provider(s). Provider portal users who have full permissions to manage SR contracts are included in the dropdown.

**NOTE:** Users who also have coalition portal access (e.g. ELC, RCMA, and DEL users) are excluded from the list as authorized provider signators.

Click the dropdown field to view all provider users who are eligible to electronically sign the SR contract. Select all users who should have authorization to sign the contract for the listed provider(s).

**NOTE:** In order for the user who is currently editing the contract to be able to electronically sign, their username must be selected.

When the authorized signator(s) are selected, click **Next Step**.
Exhibit 1: Program Assessments

After clicking the Next Step button, the Exhibit 1 page displays. If the provider is exempt from program assessment requirements, the provider must select if they want to waive the exemption. If the provider is not exempt, the option to waive exemption is not displayed.

NOTE: If the provider is exempt from program assessments and selects “Yes” to waive the exemption, the contract will be sent back to the coalition for review.

The Composite Program Assessment Score displays under Provider Eligibility. If the score is greater than or equal to 5.00, select whether the provider wants to waive their biennial status and receive an annual program assessment. If the composite program assessment score is below 5.00, the option to waive biennial status is not displayed.
Exhibit 1: Child Assessments

On the Exhibit 1 page, select if the provider elects to conduct child assessments.

If “Yes” is selected, a pop-up message appears for the provider to confirm that they have/will upload the reliability certification.
If the provider selects "Yes" to conduct child assessments, select a child assessment tool. Click **Next Step** to continue.
Exhibit 3: Quality Improvement Plan Selection

After clicking **Next Step**, the Exhibit 3 page only displays if the provider is required to participate in a quality improvement plan. Enter the user’s initials in each box that has a check mark, then click **Next Step** to continue.

<table>
<thead>
<tr>
<th>Provider Name</th>
<th>Strategy</th>
<th>Description (summary)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>COALITION approved strategy</td>
<td>Description included in QIP Notice.</td>
</tr>
<tr>
<td>Provider Name(s)</td>
<td>Certified Coaching Units</td>
<td>Each selected classroom will participate in 20 hours of certified coaching provided by the ELC or its delegate.</td>
</tr>
<tr>
<td>Provider Name(s)</td>
<td>CLASS Group Coaching (COC) Training</td>
<td>Each selected instructor/director will complete either the COC Parent 24-hour course or the COC Infant/Toddler 24-hour course provided by the COALITION’s or its delegate’s COC Specialist.</td>
</tr>
<tr>
<td>Provider Name(s)</td>
<td>Early Childhood Training System (ECTS) Courses</td>
<td>Each selected instructor/director will successfully complete the Early Childhood Training System courses facilitated by the ELC. Course options include taking an online course alone, with TA coaching support, and/or as a member of a COALITION-sponsored Community of Practice.</td>
</tr>
<tr>
<td>Provider Name(s)</td>
<td>20-hours of uACET or OEL approved training</td>
<td>Each selected instructor/director will register for and successfully complete 20 hours of International Association for Continuing Education &amp; Training (uACET) approved training (or other OEL approved OEL training) provided by the ELC or its delegate.</td>
</tr>
<tr>
<td>Provider Name(s)</td>
<td>Professional Development</td>
<td>Each selected instructor/director shall register in the Florida Early Care and Education Professional Development Registry, generate a professional development plan in the registry, and complete the required progression along the career pathway.</td>
</tr>
</tbody>
</table>
Exhibit 5: Provider Reimbursement Rates

If the provider charges an annual registration fee (Profile > Provider Profile > Fees & Discounts), the following page displays. Select the annual fee details, then click Next Step to continue.

**NOTE:** If “Month” is selected, another dropdown field appears for the provider to select a month. If “Other” is selected, the provider must provide a description.

![Exhibit 5: Provider Reimbursement Rates](image)

Exhibit 6: Holiday Schedule

After clicking Next Step, the following displays. The dates are based on any coalition-defined holidays and the closure dates from the profile Closure Calendar.

If fewer dates are listed than the coalition maximum total paid closure dates, additional provider holidays can be added to the holiday schedule exhibit if applicable. Click the Edit button on the holiday table.

![Exhibit 6: Holiday Schedule](image)
After clicking the **Edit** button, a pop-up window appears with an editable holiday table. On a blank row, enter the holiday name, then select a date from the dropdown in the Date column. Duplicate dates cannot be used. When done editing, click **Save**. Then, click **Next Step** to continue.

**Preview Contract**

Prior to executing the contract, click **Preview Contract** to view the contract. This allows the user to view all the information input into the contract and exhibits from the profile. Information added by the coalition and providers should be reviewed as well.
After clicking the **Preview Contract** button, the following displays in a new browser tab.

1. **Parties.** This Contract is made and entered into this _1st_ day of _July_, 20__ by and between the Early Learning Coalition of __________ County, therein referred to as "COALITION"), and ______________, Learning Center (herein referred to as "PROVIDER"), with its principal office located at __________, and its provider physical site address (if the single site provider physical site address is different from principal office address) located at __________.

a. **Multiple Public School Locations.** If PROVIDER is a school district executing a single Contract on behalf of multiple public school School Readiness (SR) Program PROVIDERS, a list of their names and their physical addresses are included in Exhibit 1: PROVIDER Location List. Thereafter, PROVIDER shall include each location listed in Exhibit 1.

b. **Multiple Private Locations.** If PROVIDER is executing a single Contract on behalf of multiple private SR PROVIDER sites within COALITION’s service area, a list of their names and their physical addresses are included in Exhibit 1: PROVIDER Location List. Thereafter, PROVIDER shall include each location listed in Exhibit 1.

c. **Identification Number.** Insert PROVIDER’s EIN or SSN here.

PROVIDER’s EIN (Employer Identification Number) or SSN (Social Security Number) is requested in accordance with ss. 119.071(5)(a) and 119.092, F.S., for use in the records and data systems of the Division of Early Learning and COALITION. Submission of PROVIDER’s EIN or SSN is mandatory. PROVIDER’s EIN or SSN will be used for processing payments to PROVIDER as an SR PROVIDER, for reporting those payments for federal tax purposes, and for routine identification. If PROVIDER completes Exhibit 1 listing multiple locations with multiple EIN numbers, this paragraph may be left blank.

2. **Purpose.** This Contract is designed to inform PROVIDER of the requirements of participation in the SR Program. Payment is not conveyed to PROVIDER through this Contract. Instead, PROVIDER must agree to comply with the terms and conditions of this Contract in order to
Contract Execution

To electronically sign the contract, check the By Electronic Signature checkbox.

NOTE FOR PUBLIC SCHOOLS: If a school board or school district needs to manually sign a contract, the contract can be downloaded as a .pdf and printed. An authorized representative should electronically sign and submit the contract.

After clicking the checkbox, the following message displays. Enter the Title of Signator, then click Yes.

NOTE: The Title of Signator is not the provider’s name, but the business title, e.g. Owner, Director, Principal.

After clicking the Yes button, the electronic signature of the signatory, printed name, title, and the date/time will populate, highlighted in yellow. Click Next Step to continue.

NOTE: The electronic signature and printed name of the user is based on the user who is logged on to the portal. Please ensure that the proper user is logged on to electronically sign the contract. If the incorrect name is used for the electronic signature, the checkbox can be un-checked.
You are about to remove your signature from the Form OEL-VPK 20.

Click "Yes" to continue.

<table>
<thead>
<tr>
<th>Owner</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print Name</th>
<th>4/13/2020 1:39:34 PM</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Provider's Additional Signature (if required by the Provider)</th>
<th>Print Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signature of Authorized Coalition Representative</th>
<th>Print Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>
Contract Certification

After clicking the **Next Step** button, the following page displays. Enter the full name of the user who is logged on, title, and click the **Certified by electronic signature** checkbox. Click **Submit**.

In accordance with s. 1002.88(1)(g), F.S., PROVIDER has caused this Contract to be executed as of the date set forth in Paragraph 1. By signing below, PROVIDER hereby certifies that PROVIDER has read and understood this Contract. PROVIDER certifies that all information provided is true and correct and agrees that noncompliance with the requirements of the School Readiness Program including, but not limited to the requirements of this Contract, and all Exhibits and authorized attachments, shall result in corrective action, withholding of funds, or termination of this Contract at the discretion of COALITION, in accordance with Section X.

**Warranty of Authority.** Each person signing this contract warrants that he or she is duly authorized to do so and to bind the respective party to the contract.

**By signing this form I certify that:**

- I had the opportunity to review the Statewide School Readiness (SR) Provider Contract.
- I have examined this contract and, to the best of my knowledge and belief, the information provided is true and correct.
- I understand that upon the approval of my provider's contract, I will receive notification my contract is in force.
- I am duly authorized to sign and bind the respective party to the contract.

After clicking the **Submit** button, the following message will display and an email will be sent by DONOTREPLY@OEL.myflorida.com.
Navigate to the provider manage contracts page (Contracts > Manage Contracts). The SR contract will have a status of Submitted for the coalition to review.
VPK Contract

After the coalition has initiated a VPK contract, the user will navigate to **Contracts > Manage Contracts** from the Provider Dashboard.

The manage contract page displays. Click the **Edit** button for the initiated DEL-VPK 20.
Compensation and Funding: Advance Pay Options

After clicking the **Edit** button, the following page displays. When the user’s pointer hovers over the dropdown fields, a tool tip informs the user that the advance payment selections will apply to all sites on the contract.

Select an Advance Payment Option for the school year and summer programs. Click **Next Step** to continue.
Exhibit 1: Provider Location List Attachment

After clicking the **Next Step** button, the following displays. Select the School Year and/or Summer checkbox if the session is offered. Click **Next Step** to continue.

---

Preview Contract

Prior to executing the contract, click **Preview Contract** to view the contract. This allows the user to view all the information input into the contract and exhibits from the profile. Information added by the coalition and provider should be reviewed as well.

---
I. PARTIES AND TERMS OF CONTRACT

1. **Parties.** This Contract is made and entered into this __1st__ day of __July__, 20__22__, by and between the Early Learning Coalition of __TALLAHASSEE__ (herein referred to as “COALITION”), and __KIM TEST PROVIDER__ (doing business as, if applicable) __Kim's Test Daycare #3__ (herein referred to as “PROVIDER”), with its principal office located at __2307 HOME CT TALLAHASSEE, FL 32303__ and its provider physical site address (if the single site provider physical site address is different from principal office address) located at __1833 N MONROE ST TALLAHASSEE, FL 32303__.

   a. **Multiple Public School Locations.** If PROVIDER is a school district executing a single Contract on behalf of multiple public school Voluntary Prekindergarten (VPK) Education Program providers, a list of their names and their physical addresses are included in Exhibit 1: Provider Location List. Thereafter PROVIDER shall include each entity listed in Exhibit 1.

   b. **Multiple Private Provider Locations.** If PROVIDER is executing a single Contract on behalf of multiple private VPK provider sites within COALITION’s service area, a list of their names and their physical addresses are included in Exhibit 1: Provider Location List. Thereafter PROVIDER shall include each entity listed in Exhibit 1.

   c. **Identification Number.** Insert PROVIDER’S __☐ EIN__ or __☒ SSN__ here: __TEST111__

      PROVIDER’s EIN (Employer Identification Number) or SSN (Social Security Number) is requested in accordance with ss.119.071(5)(a), and 119.092, F.S., for use in the records and data systems of the Department of Education and COALITION. Submission of PROVIDER’s EIN or SSN is mandatory. PROVIDER’s EIN or SSN will be used for processing payments to PROVIDER as a VPK provider, for reporting those payments for federal tax purposes, and for routine identification.

2. **Purpose.** This Contract is designed to inform PROVIDER of the requirements of participation in the VPK Program. Payment is not conveyed to PROVIDER through this Contract. Instead, PROVIDER must agree to comply with the terms and conditions of this Contract in order to be eligible to participate in the VPK Program. This Contract is to engage an eligible provider to
Contract Execution
To electronically sign the contract, click the **By Electronic Signature** checkbox.

**NOTE FOR PUBLIC SCHOOLS:** If a school board or school district needs to manually sign a contract, it can be downloaded as a .pdf and printed.

After clicking the checkbox, the following message displays. Enter the **Title of Signator**, then click **Yes**.

**NOTE:** The **Title of Signator** is not the provider’s name, but the business title, e.g. Owner, Director, Principal.
After clicking the **Yes** button, the electronic signature of the signatory, printed name, title, and the date/time will populate, highlighted in yellow. Click **Next Step** to continue.

**NOTE:** The electronic signature and printed name of the user is based on the user who is logged on to the portal. Please ensure that the proper user is logged on to electronically sign the contract. If the incorrect name is used for the electronic signature, the checkbox can be un-checked.
Contract Certification

After clicking the **Next Step** button, the following will display. Enter the full name of the user who is logged on, title, and click the **Certified by electronic signature** checkbox. Click **Submit**.

After clicking the **Submit** button, the following message will display and an email will be sent by **DONOTREPLY@OEL.myflorida.com**.

---

**You Have Successfully Completed, Signed, Certified and Submitted your Statewide VPK Provider Contract**

Your early learning coalition will review and process your contract. You may not offer VPK services until you have received notification that your contract has been approved and fully executed by your coalition. Please check your email for important information regarding your contract.

You can click on the button below to return to your home page.

---

**Statewide VPK Provider Contract Submitted**

Hello Jim Ladebetter,

The Statewide VPK Provider Contract (Venna OEL-VPK-20, 20R052) you submitted for Jim’s House of Smarties has been delivered to the ELCC of the Big Bend Region. The contract will be reviewed and you will receive an email with further instructions.

Remember, you must receive a copy of the Statewide VPK Provider Contract signed by the coalition before reserving payment or beginning VPK classes.

Thank you,

ELCC of the Big Bend Region
(850) 970-6000
http://www.elcc.com/

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have questions, please contact your [coalition representative](mailto:coalition@myflorida.com).
Navigate to the provider manage contracts page (Contracts > Manage Contracts). The SR contract will have a status of **Submitted** for the coalition to review.
VPK-APP
The VPK-APP replaces forms DEL-VPK 10 (Provider Application), DEL-VPK 11A (Class Registration – Instructors), and DEL-VPK 11B (Class Registration – Calendars). The tabs must be done in order of appearance (Attendance Policy, then VPK Director, etc.); the answers in one tab populate information in the next tab.

After the coalition has initiated the provider application, the Provider Portal user will click Manage Contracts from the Provider Dashboard.

The following will display. Click the Edit button to review the contract.

<table>
<thead>
<tr>
<th>Contract ID</th>
<th>Type of Contract</th>
<th>Contract Name</th>
<th>Coalition</th>
<th>Status</th>
<th>Last Updated</th>
<th>Action</th>
<th>View Contract</th>
<th>Start Date</th>
<th>End Date</th>
<th>Termination Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>44</td>
<td>VPK-APP</td>
<td>VPK 10, 11A, 11B</td>
<td>ELC of North Florida/Episcopal Children’s Services</td>
<td>Initiated</td>
<td>4/20/2017</td>
<td>None</td>
<td>None</td>
<td>7/1/2017</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 1 – Attendance Policy
The Attendance Policy tab allows the Provider Portal user to upload the provider Attendance Policy. The document that is to be distributed to parents must be uploaded by clicking the Browse button, finding the document in the electronic files and clicking the Upload button.
Step 2 – VPK Director

The VPK Director tab allows the Provider Portal user to add information and upload documents for the primary VPK Director that will be listed on the DEL-VPK 10. Click the **Add New Director** button to begin.

Click the **Save** button after all information is entered for the director.

**NOTE:** The Credential Type, Credential Certificate Number, Credential Issue Date, and Credential Expiration Date will not appear for public schools.

Once the VPK Director is added, the supporting documents may be added by clicking **Edit**.
The Provider Portal user will select the document type, browse to select a file, enter the document issue or expiration date (if applicable), and click **Upload**. Then, click **Save**. At least one document should be uploaded.

### Step 3 – VPK Instructors

The VPK Instructors tab allows the Provider Portal user to add information and upload documents for each instructor. Click the **Add New Instructor** button to begin.

Click the **Save** button after all information is entered for each instructor.
Once the VPK Instructor is added, the supporting documents may be added by clicking **Edit**.

The Provider Portal user will select the document type, browse to select a file, enter the document issue or expiration date (if applicable), and click **Upload**. Then, click **Save**. At least one document should be uploaded.

**NOTE:** If a VPK Instructor achieves new certifications and moves from a sub to an aide, create a new record for that Instructor. If the Instructor Type is only changed from sub to aide, the maximum class size will not increase to 20 in a class that already has a Lead Instructor.

**Step 4 – VPK Calendars**

The VPK Calendars tab allows the Provider Portal user to provide information regarding each unique class calendar which will be offered at the VPK site. If classes are offered at identical times on identical dates, they utilize the same class calendar (e.g., all classes are scheduled from 8:00am to 11:00am, Monday through Friday, starting on January 11). If classes are not offered at identical times on identical dates, they utilize unique class calendars which must be created separately. Click the **Add New Calendar** button to begin.

The Calendar ID will automatically populate with a letter beginning with A. Each additional calendar will receive a sequential Calendar ID.

The Calendar Name is an optional field. It may be used for a short nickname such as “Fall AM.”
The program type selection of School-Year (540 hours) or Summer (300 hours) is required. The program selected will determine the valid calendar date range. The Calendar Start Date and Calendar End Date must be within the valid calendar date range. The Calendar Start Date and Calendar End Dates should reflect the first day VPK instruction will be delivered and the final day VPK instruction will be delivered.

Next, the instructional days, start time and end time must be added by checking the box by the days of the week that VPK instruction will be delivered and entering the times of VPK instruction for the days of the week that VPK instruction will be delivered.

After the instructional days, start time and end time are added, the Total Calculated Hours and Total VPK Instructional Days sections will populate.

Providers are to use the calendar to note any non-instructional days on which VPK instruction will not be delivered (such as vacations or holidays) and exceptions to normal instructional days that occur during the defined calendar start and end date. Entering Non-Instructional Days and Instructional Day Exceptions can increase or decrease the Total Calculated Hours.
For example, if the Total Calculated Hours exceed 300 hours for the summer program type or 540 hours for the school-year program type (as shown in the example above), the user may remove a day (or more) by labeling it a Non-Instructional Day. Each Non-Instructional Day entered will deduct the hours assigned to that day, thereby decreasing the Total Calculated Hours. Instructional Day Exceptions can be used to change the hours assigned to that day (to increase or decrease the hours). For example, if the calendar is a few hours short, an instructional day’s hours may be extended to increase the Total Calculated Hours. To add a Non-Instructional Day or an Instructional Day Exception to the calendar, click on that date on the calendar. Multiple days can be selected by clicking and dragging across multiple days on the calendar.

After clicking on a date, a pop-up message will appear. The Provider Portal user must select the Event Type and enter a short description. When an Instructional Day Exception is selected, the user must also enter the time range for the day.

Click the Update button to save changes. Click the Remove button to remove an existing Non-Instructional Day or Instructional Day Exception created on the calendar.
When the Total Calculated Hours match the hours for the VPK program type, the user will click the **Save** button.

**NOTE**: The hours must equal, or be fewer than, 300 hours for the summer program type or 540 hours for the school-year program type for the calendar to save.
Step 5 – VPK Class(es)

The VPK Class(es) tab allows the Provider Portal user to build VPK classes and assign instructor(s) to them. Click the **Add New Class** button to begin.

The Class ID will automatically populate after the Class Calendar is selected. The Class ID is created using a sequential letter beginning with A. In the second space, either an “F” for school-year (fall) or “S” for summer will appear. The F and S is derived from the calendar’s program type. The last two digits represent the last two numbers of the program year. Each additional class will receive a sequential Class ID.

The Class Name is an optional field. It may be used for a short nickname such as “Blue Room.”

The Main Curriculum drop down is populated with selections made from the provider’s profile.

The Class Start Date and Class End Date are populated with the Calendar Start Date and End Date.

The Instructors are populated with individuals from the VPK Instructors tab. Check the checkbox in front of the instructor to add them to the class, then enter the Instruction Start Date. If the class has not started, the Instruction Start Date defaults to the Class Start Date. For each class, one Lead Instructor must be selected. Click the **Save** button after all information is entered for each class.
**Step 6 – Review**

During the review process, the Provider Portal user can click the **Edit** button to make any changes to a section. After reviewing the information for each section, the user must click the **Certify and Submit** tab button to continue.
Step 7 – Certify and Submit
To submit the VPK-APP, the Signer’s Name must exactly match the name entered in the Provider Profile, the Provider Portal user must fill in the phone number, check the “Check box to certify by electronic signature” check box and click the Submit VPK Provider Application button.

**Certify and Submit**

By signing this form I certify that:

- To the best of my knowledge and belief, the information provided is true and correct.
- If any information changes, I (PROVIDER) will notify the COALITION within 14 days of the change.
- I understand that if changes implemented prior to receipt of COALITION approval may result in noncompliance with VPK requirements.
- Each VPK instructor listed has submitted an affirmation of good moral character, has provided documentation to be maintained in the files of the PROVIDER/DISTRICT and the COALITION documenting that the individual has undergone a Level 2 background screening within the previous five (5) years in accordance with section 416.94, F.S., which demonstrates that the individual is not ineligible to act as a VPK instructor, and is not ineligible to teach in a public school because the instructor’s educator certificate has been suspended or revoked.
- Each credentialed VPK instructor listed has the credentials required for the VPK program.
- I understand that my information will be shared with the Department of Children and Families, Office of Child Care Regulation, for inclusion in the CARES system.

![Provider Signature](image)

**You Have Successfully Completed and Submitted your VPK Provider Application!**

Congratulations, you have successfully submitted your VPK Provider application.

Your early learning coalition will process your application.

Please check your email for important information about your application.

From here you can:

- Return to dashboard
- Log off
Updating a VPK-APP

A Provider Portal user can edit a VPK-APP by clicking the **Edit** button on their Manage Contracts page. Clicking the **Download** button will export the information in the VPK-APP to a .pdf document.

### VPK Director

To edit the current director’s information in the VPK Director tab, click the **Edit** button. To remove a director, click the **Remove** button. To add a new director, click the **Add New Director** button. To edit the current supporting document, or add a new document, click the **Edit** button.

When the **Remove** button is clicked, the following message will display.

**Remove Not Jim Ledbetter?**

- You are about to remove this director and make him/her inactive. All information and documents (if any) will be retained. You may re-add this director at a later time if needed. To continue, enter the last day this individual served as VPK Director and click Remove, otherwise click Cancel.

Once the director’s last day is entered and the **Remove** button is clicked, the director will no longer appear on the VPK Director screen, unless the **Show removed directors** checkbox is checked. The director can be re-added by clicking the **Re-add** button.
VPK Instructors

To edit the current instructors’ information in the VPK Instructors tab, click the Edit button. To add a new instructor, click the Add New Instructor button. To remove an instructor, click the Remove button. To edit the current supporting document(s), or add a new document, click the Edit button.

If the instructor has not been assigned to a class, when the Remove button is clicked, the following message will display.

⚠️ Remove Not Jim Ledbetter?

You are about to remove this instructor and make him/her inactive. All information and documents (if any) will be retained. You may re-add this instructor at a later time if needed. To continue, click Remove, otherwise click Cancel.

Cancel Remove
Once the **Remove** button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the **Show removed class instructors** checkbox is checked. The instructor can be re-added by clicking the **Re-add** button.

If the instructor has been assigned to a class, when the **Remove** button is clicked, the following message will display.

- **Instructor is currently assigned**

This action cannot be performed because the instructor is currently assigned to a class. Please remove the instructor from all classes first.

To remove an instructor from a class, go to the VPK Class(es) section and click the **Edit** button for the class.
In the Instructors area, uncheck the instructor’s name. Once un-checked, enter the Last Taught Date, or click the **Never began instruction of class** checkbox if the class has not started. Click **Save**.

The VPK Classes tab will now show that the instructor is removed from the class.

Now that the instructor is no longer assigned to any class, the Provider Portal user may go to the VPK Instructors tab to remove the instructor by clicking **Remove**. The following message will display:

**Remove Not Jim Ledbetter?**

- You are about to remove this instructor and make him/her inactive. All information and documents (if any) will be retained. You may re-add this instructor at a later time if needed. To continue, click Remove, otherwise click Cancel.
Once the **Remove** button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the **Show removed class instructors** checkbox is checked. The instructor can be re-added by clicking the **Re-add** button.

The **Review** tab is also updated with the Instructor removal information.
VPK Calendars

To edit the current calendar in the VPK Calendars tab, click the **Edit** button, make any necessary edits, and click the **Save** button. To remove a calendar, click the **Remove** button. To add a new calendar, click the **Add New Calendar** button.

If there are no classes assigned to a calendar, when the **Remove** button is clicked, the following message will display:

Remove ?

- You are about to remove this calendar and make it inactive. You may re-add this calendar at a later time if needed. Are you sure you want to remove this calendar?

If there are classes assigned to a calendar, the following message will display:

- Calendar is currently assigned

- This action cannot be performed because the calendar is currently assigned to a class. If the class has not started yet, you may remove the calendar from the class and try this action again.
Once a calendar is removed, the calendar will no longer appear on the VPK Calendars screen, unless the Show removed calendars checkbox is checked. The calendar can be re-added by clicking the Re-add button.

NOTE: Calendar End Dates and Class End Dates are editable.

The Calendar End Date can be changed to reflect changes in Non-Instructional Days or holidays that are added after the calendar begins. Changing the Calendar End Date will update the Class End Date and the Instructor Last Taught Date.
After the calendar is changed, if the provider needs to change the Instruction Start Date of an instructor, the provider will un-check and re-check the checkbox for each instructor and edit the date.
The Calendar Name can be added if the provider did not add a Calendar Name when the calendar was created.
VPK Class(es)

To edit the current class information in the VPK Class(es) tab, click the **Edit** button. To add a new class, click the **Add New Class** button. To remove a class, click the **Remove** button. After all edits have been made for each class, click the **Save** button.

Classes that have started may not be removed. Limited editing is available.
If the class has not started, when the **Remove** button is clicked, the following message will display:

Remove ?

⚠️ Are you sure you want to remove this classroom?

Once the **Remove** button is clicked, the class will no longer appear on the VPK Class(es) screen, unless the **Show removed classes** checkbox is checked.
To end the class, click the **Edit** button and change the Class End Date to reflect the last day that VPK instruction was provided. The Instructor Last Taught Date will be updated to the Class End Date after clicking the **Save** button.

The Review tab will now reflect the updated class information.
Editing an SR Contract Amendment

Navigate to **Contracts > Manage Contracts**.

The Manage Contracts page for the provider site displays. Click the plus “+” sign to the left of the DEL-SR 20 contract to expand the amendment section. The **Edit** button is available when the amendment is in one of the following statuses:

- Initiated
- Rejected
- Incomplete

Click the **Edit** button.

**NOTE:** If the amendment status is **Initiated** or **Rejected**, the status changes to **Incomplete** while the amendment is being edited.
Review the Provider(s), Provider Eligibility, Notification, and Signature Authority sections.

- PROVIDER RESPONSIBILITIES AND SCOPE OF WORK – If applicable, the contracted slots question displays. Select a response.
- NOTIFICATION – Enter any changes to the provider contact information, if applicable.
- SIGNATURE AUTHORITY – If any changes are needed to the existing signature authority selections, click the dropdown menu. Select all users who are authorized to sign contracts and amendments. To remove a Signator, deselect the user(s) to be removed.

NOTES:
- Any previously selected users should remain selected if they are still authorized signatories.
- Users with coalition portal aces will not be on the authorized signators list.

Click **Next Step** to proceed to the Exhibit 1 page.
Below is an example of an amendment for a multiple-site provider where a new site is being added to the contract. The page displays both providers currently on the contract and the new site being added to the contract.

**Original Provider**

- **PROVIDER ELIGIBILITY** – If the provider’s Composite Program Assessment Score is 5.00 or greater, the provider can change their selection for waiving their biennial status and enter a reason for modification.  
  **NOTE:** If the provider is answering the question for the first time, a response (Yes or No) is required.

- **PROVIDER RESPONSIBILITIES AND SCOPE OF WORK** – If a change is needed to the provider’s selection to conduct child assessments (ONLY during the appropriate child assessment period) or the child assessment tool needs to be changed, make the new selections and enter the reason for modification.

**Added Provider**

If a provider is being ADDED to the contract:

- **PROVIDER ELIGIBILITY**
  - If the provider is exempt from Program Assessment requirements, select if the provider wants to waive their exemption and receive a program assessment.
  - If the provider has a Composite Program Assessment Score of 5.00 or greater, select if the provider agrees to waive their biennial status and agree to an annual program assessment.

- **PROVIDER RESPONSIBILITIES AND SCOPE OF WORK** – Select if the provider conducts child assessments. If yes, select the assessment tool.

Click **Next Step** to continue.
The Exhibit 3: Quality Improvement Plan (QIP) Selection page displays if the coalition selected a new QIP strategy. If Exhibit 3 displays, initial the selected strategy. Then, click **Next Step**.

The Exhibit 5 page for registration fee displays if the provider charges an annual registration fee. If a change is needed to the annual fee collection frequency, make a new selection (Month, Upon Enrollment, or Other).

If a new provider site is being added to the contract and they charge an annual registration fee, an annual collection frequency is required (Month, Upon Enrollment, or Other). Click **Next Step** to continue.
The Exhibit 6: Holiday Schedule page displays. Click the **Edit** button to add or remove holidays, if applicable.

**NOTE:** Coalition paid holidays cannot be edited by the provider.
To save your changes, click **Save** in the edit window, then click **Close** to close the window. Click **Next Step** to proceed.

On the Amendment Signatures page, click the **Preview** button to review the DEL-SR 20A form to verify changes before signing and submitting the amendment. Click the “By Electronic Signature” box to electronically sign the amendment.
Enter the Title of Signator (NOT the Signator’s name), then click **Yes** to proceed with electronically signing the amendment. Click **Cancel** to close the window without signing.

NOTE: To add an additional signature, click Cancel and have the other Signator log in with their username to sign the amendment before submitting. To remove the provider’s signature before submitting the amendment, deselect the “By Electronic Signature” box and click **Yes** in the confirmation pop-up window.

When **Yes** is clicked in the pop-up window, the signator’s signature, printed name, title and the date are populated and saved. Click **Submit** to proceed.
On the SR Amendment Certification page, enter Full Name and Title, then click the “Certified by electronic signature box.” Click **Submit** to submit the amendment to the coalition.

A message that you have successfully completed, signed, certified, and submitted your SR amendment displays.

Navigate to **Contracts > Manage Contracts** to view the submitted amendment. Click the plus “+” sign to the left of the DEL-SR 20 contract to expand the amendment section. The amendment is in **Submitted** status. Click the **View** button to preview the amendment in a new browser tab.
Viewing a Certified SR Contract Amendment

After the coalition certifies the SR amendment, navigate to **Contracts > Manage Contracts**.

The Manage Contracts page displays. Click the plus “+” sign to the left of the DEL-SR 20 contract to expand the amendment section. The amendment is in **Certified** status.

To download a PDF of the certified DEL-SR 20A and any associated exhibits, click the **Download** button.
Editing a VPK Contract Amendment

Navigate to Contracts > Manage Contracts.

The Manage Contracts page for the provider site displays. Click the plus “+” sign to the left of the DEL-SR 20 contract to expand the amendment section. The Edit button is available when the amendment is in one of the following statuses:

- Initiated
- Rejected
- Incomplete

Click the Edit button.

**NOTE:** If the amendment status is Initiated or Rejected, the status changes to Incomplete while the amendment is being edited.
The Compensation and Funding page displays. The advance payment selections default to the selections on the VPK contract or latest amendment. If a change is needed, select the new advance payment option for the school year and/or summer programs. Click **Next Step** to continue.

**NOTE:** For VPK contracts with multiple sites, changing the advance payment selection will affect all sites on the contract. If you are a provider on a multiple-site contract and you intend to change the advance payment selection(s) for specific sites, but not all, contact your coalition to remove those sites from the contract. A separate VPK contract will need to be executed for the provider sites that are removed from the contract.

If one or more provider is being added to the contract, the Exhibit 1: Provider Location List Attachment displays. Select the box for school year and/or summer if the provider will offer the session, then click **Next Step**.
The Amendment Signatures page displays. To preview the DEL-VPK 20A form, click Preview Amendment.

The DEL-VPK 20A loads in a new browser tab.

I. General Amendment Information

Amendment Number: 28718

II. Parties and Terms of Contract Amendment

This AMENDMENT to the Statewide Voluntary Prekindergarten (VPK) Provider Contract is entered into between the Early Learning Coalition of Alachua and INC, VPK provider (PROVIDER),

WHEREAS, on 7/1/2022, the Early Learning Coalition of Alachua entered into the Contract with this Provider to provide VPK services; and

WHEREAS, PROVIDER desires to amend this Contract to replace, delete, or supplement one of the following provisions of the existing Contract; and

WHEREAS, the Early Learning Coalition of Alachua agrees to amend the Statewide Voluntary Prekindergarten Provider Contract as indicated in Section III.

III. Amendments

The Contract is hereby amended to replace the following as noted below (check each applicable box for the modified term(s)).

- Location of the Provider’s Principal Office. The deleted address is: Gainesville, FL 32601-2169.
  The replacement address is: Gainesville, FL 32601-2169.

  Reason for modification: Removed duplicate Address 2.

- Provider Type (Modification to DEL-VPK 208). The original provider type selected is:
To sign the amendment electronically, on the Amendment Signatures page, click the box for the provider authorized representative.

When the electronic signature box is checked, a pop-up window displays. Enter the Signator’s title (not the name), then click Yes to proceed with electronically signing the amendment, or click Cancel to close the window without signing.
When **Yes** is clicked, the signator’s signature, printed name, title and the date/time are populated and saved. Click **Submit**.

To remove the provider’s signature before submitting the amendment, unselect the By Electronic Signature box and click **Yes** in the confirmation pop-up window.

**NOTE:** To add an additional signature, have the other Signator log in to sign the amendment before submitting.

When the **Submit** button is clicked on the signatures page, the VPK Amendment Certification page displays. Enter Full Name and Title, and click the “Certified by electronic signature box.” Click **Submit**.
The successfully completed, signed, certified, and submitted message appears.

Navigate to **Contracts > Manage Contracts**.

The Manage Contracts page displays. Click the plus “+” sign to the left of the VPK contract that is being amended to expand the amendment section. The amendment is in **Submitted** status.

To preview the submitted DEL-VPK 20A form and any associated exhibits, click the **View** button.
Viewing a Certified VPK Contract Amendment

Navigate to **Contracts > Manage Contracts**.

The Manage Contracts page displays. Click the plus “+” sign to the left of the VPK contract to expand the amendment section. The amendment is in **Certified** status.

To preview the certified DEL-VPK 20A form and any associated exhibits, click the **View** button, or click the **Download** button to download the amendment as a PDF.

**NOTE:** The amendment status changes from **Initiated** to **Incomplete** while the amendment is being edited.
Enrollments - VPK

VPK Providers may manage VPK enrollment online by going to Enrollments > Manage VPK Enrollments. Two options are available: Request/Change Enrollment and Bulk File Upload.

Request/Change Enrollment

This feature allows VPK Providers to request or change enrollment for children in verified classes submitted through the VPK Provider Application. To begin, select the VPK Program Year, VPK Session, and VPK Class.

With the VPK Program Year, VPK Session, and VPK Class selected, the class start date and end date appear as well as the max class size. This information is directly tied to the VPK Provider Application. For example, if there is one lead instructor for the school-year session submitted and verified on the VPK Provider Application, the max class size will be 11; if there are two instructors for the school-year session submitted and verified on the VPK Provider Application, the max class size will be 20.

Next, the VPK children count and Non-VPK children count are displayed. These two counts (summed together) cannot exceed the max class size. The Non-VPK children count is used to anonymously indicate private pay children participating in the VPK class. The Non-VPK children count defaults to zero. When the Non-VPK children count is used, the number of VPK children permitted in the class is reduced to maintain the max class size limit.
The class roster records are also displayed. If there are no children enrolled in the class, a "No records found for this class" message displays.

If there are/were children enrolled in the class, the records are listed with the current enrollment status (Enrolled, Enrolled-Change Requested, or Enrollment Ended (Terminated)).

### Enrolling a VPK Child

Using the child’s approved Certificate of Eligibility (COE) provided by the family, enter the Certificate Number, Child First Name, Child Last Name, and Child DOB. Then, click **Enroll to this Class**.

**NOTE:** The fields are not case sensitive; however, the certificate number must be entered exactly as it appears on the COE (i.e. VPK####-YYYY).
The system verifies that the information entered matches a child with an approved COE for the VPK program year selected and that the child is not already enrolled (or in a non-eligible status for enrollment).

**NOTE:** The county on the COE does not have to match the provider’s county because the child has been deemed eligible to participate in the VPK program. The enrollment process automatically updates the child’s county for service to the provider’s county so the corresponding early learning coalition may manage the child’s enrollment with the provider.

When a matching child is found and validations checks are successful, a confirmation message appears. To continue, click **Yes**.

Next, the system asks for the Anticipated Start Date. This is the date the child will begin attending class. Typically, this is the class start date unless the child is starting after the class begins.

**NOTE:** An anticipated start date cannot be before the class start date or after the class end date. And, an anticipated start date cannot be before the child’s COE issue date (as displayed on the child’s COE and listed in the enrollment window).
The system validates each enrollment request to make sure the max class size is not exceeded (based on the number of instructors assigned, the VPK session type, and current class enrollment count). To continue, click **Enroll Child**.

When the enrollment request is successful, the child appears on the class’s enrollment roster as “Enrollment Submitted” and the coalition receives the enrollment request for review/approval/rejection. In addition, the family receives a notification that their child’s enrollment is in progress.

While the enrollment request is being processed by the coalition, the status is updated on the enrollment roster. For example, the coalition has changed the status to Coalition Reviewing.

If the coalition rejects or cancels the enrollment request, the child will no longer appear on the class roster. The VPK Director and family will receive an email notification. The family is instructed to download their child’s COE from the Family Portal and re-start the enrollment process.
When the enrollment process is approved by the coalition, the child’s status is Enrolled.

Managing VPK Enrollment
The class roster has several features for managing enrollment. Providers may change the anticipated start date, request to move the child to another class, remove the child entirely from the roster because they never attended, or request a termination of services.

Change Anticipated Start Date
To change the child’s anticipated start date, click Change within the Anticipated Start Date column. A window displays. The current start date populates in the From field; enter the new start date in the To field. This feature does not require coalition approval. Click Save to commit the new date or click Close to abandon the date change and close the window. This feature is available until the actual start date is recorded through the attendance process. When the actual start date is populated in the column, the Change button is no longer available.

Class Change
Once the child's status is Enrolled, a class change may be requested. To change the child’s class, click Class Change within the Actions column. A window displays. The current class populates in the From field; select the new class in the To field and enter the Transfer Effective Date. The Transfer Effective Date should be the first day the child will attend the new class. This feature requires coalition approval. Click Submit Request to send the request to the coalition or click Close to abandon the class change and close the window.

NOTE: Once a class change request is submitted to the coalition, a subsequent class change request for the same child is not allowed until the initial class change request is processed by the coalition.
Now that the class transfer request is submitted, the child appears on the roster for both classes. In the From class, the child’s status is Enrolled.

In the To class, the child’s status is Enrolled - Change Requested.

When approved, the From class has a termination effective date (same as the transfer effective date). If the termination effective date has not passed, the status is Enrolled. When the termination effective date occurs, the status will be Enrollment Ended. No further actions can be taken on this enrollment.
When approved, the To class is Enrolled with an anticipated start date and actual start date (same as the transfer effective date).

**NOTE:** A class transfer request cannot be submitted for a child if the transfer effective date overlaps an existing enrollment period for that child. If the transfer effective date is BEFORE the termination effective date of the last enrollment, an error message appears, “The class transfer effective date overlaps an existing enrollment period for this child.”

When rejected, the request no longer appears in the To class. The child remains enrolled in the From class.

**Class Change to a Full Class**

If a provider wants to move a child from class BF18 to class AF18, but class AF18 is full, the class change can still be done.

Class BF18 is not full.
Class AF18 is full.

Daisy Mae Daycare

The provider wants to move Blue Fairy Latham to AF18 from BF18.

Change Child Enrollment

Certificate Number: VPK752-2018
Certificate Issue Date: 07/29/2018
Child Name: Blue Fairy Latham
Child Date Of Birth: 08/08/2013
Anticipated Start Date: 12/10/2018
Class ID: BF18 - Forest Room

Transfer Child Class

Coalition approval required

From: BF18 - Forest Room
To: —Select—

Transfer Effective Date: MM/DD/YYYY
The provider selects AF18 in the To field and enters the Transfer Effective Date. Once the Submit Request button is clicked, the provider receives a red message.

**Change Child Enrollment**

<table>
<thead>
<tr>
<th>Certificate Number:</th>
<th>VPK752-2018</th>
<th>Certificate Issue Date:</th>
<th>07/29/2018</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Name:</td>
<td>Blue Fairy Latham</td>
<td>Child Date Of Birth:</td>
<td>08/08/2013</td>
</tr>
<tr>
<td>Anticipated Start Date:</td>
<td>12/10/2018</td>
<td>Class ID:</td>
<td>BF18 - Forest Room</td>
</tr>
</tbody>
</table>

**Transfer Child Class**

- Coalition approval required
- From: BF18 - Forest Room
- To: AF18 - Flower Room
- Transfer Effective Date: 02/27/2019

- Target class is full. Please choose a valid class or select the swap child feature.

- Submit Request
- Close
Now, the provider can either select a class that is not full, or select a child to swap with in the full class. Click the **Submit Request** button to complete the class change.

<table>
<thead>
<tr>
<th>Certificate Number:</th>
<th>VPK752-2018</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate Issue Date:</td>
<td>07/20/2018</td>
</tr>
<tr>
<td>Child Name:</td>
<td>Blue Fairy Latham</td>
</tr>
<tr>
<td>Child Date Of Birth:</td>
<td>08/08/2013</td>
</tr>
<tr>
<td>Anticipated Start Date:</td>
<td>12/10/2018</td>
</tr>
<tr>
<td>Class ID:</td>
<td>BF18 - Forest Room</td>
</tr>
</tbody>
</table>

**Transfer Child Class**

- **Coalition approval required**

  - From: BF18 - Forest Room
  - To: AF18 - Flower Room

  - Transfer Effective Date: 02/27/2019

**Swap spot with enrolled child from selected class.**

- Swap spot with: Ariel Latham

Target class is full. Please choose a valid class or select the swap child feature.

**Submit Request**

**Close**
**Never Attended**

To remove a child from a class completely because they never attended, click **Never Attended** within the Actions column. A window displays. This feature does not require coalition approval. Click **Yes** to remove the child or click **No** to abandon the removal and close the window. Removing an enrollment changes the record’s status to **Enrollment Cancelled** and the enrollment process starts over for the family. The provider’s VPK Director will receive an email notification to inform them the enrollment is removed; no attendance or reimbursement may be sought. The child’s record is no longer listed on the class enrollment roster or attendance roster in the Provider Portal. The family will receive an email notification to inform them the enrollment for their child was cancelled; instructions are provided to log into the Family Portal to download the child’s COE and select another VPK provider.

This feature is available until the actual start date is recorded through the attendance process. When the actual start date is populated in the column, the **Never Attended** button is no longer available.

**NOTE:** Be very careful with the **Never Attended** feature. If the intention is to transfer the child to a different classroom, use the **Class Change** feature. If the child attended class, VPK instructional hours were used, and reimbursement is needed, use the **Terminate** feature.
Terminate

To terminate a child’s enrollment, click **Terminate** within the Termination Effective Date column. A window displays. Enter the last day that services will be/were rendered and select the reason for termination. The Termination Effective Date is displayed below the Last Day of Services as one day after the last day of services. Therefore, the Termination Effective Date is the first day the child is NOT attending class. This feature requires coalition approval. Click **Submit Request** to send the request to the coalition or click **Close** to abandon the termination request and close the window.

**NOTE:** A child’s enrollment cannot be terminated before the class start date. If the provider enters a date in the Last Day of Services that is BEFORE the class start date, an error message appears, “Termination effective date cannot be prior to the class start date.” If the child never attended, click the **Never Attended** button to cancel the enrollment.” Either enter a termination date that is after the class start date (and on or after the COE issue date), or click **Close** to abandon the termination request and close the window.

When the termination request is submitted, the child appears on the class’s enrollment roster as “Enrolled - Change Requested.” The coalition will receive the termination request for review/approval/rejection.

When the termination request is approved and the termination effective date has not passed, the status is Enrolled. When the termination effective date occurs, the status will be Enrollment Ended. No further actions can be taken on this enrollment.
When rejected, the child remains enrolled in the class.

VPK Bulk Enrollment Process
In addition to the enrollment method described in “Enrolling a VPK Child,” providers may submit enrollment requests to the coalition via a file process. To begin, click the Bulk VPK Enrollment tab. The bulk file processing page displays.

Next, click on the link to download the CSV file template. The file may appear at the bottom of the computer screen depending on the user’s browser.

Open the file and expand the columns. Each column is explained below.
A. **Provider ID** = this is the provider ID for the site displayed on the Provider Portal home page/dashboard.

![Provider Site Summary](image)

B. **Certification Number** = this is the child’s certificate number listed on their COE. The field is not case sensitive, however, the certificate number must be entered exactly as it appears on the COE (i.e. VPK####-YYYY).

![Child Certificate of Eligibility](image)

C. **Child First Name** = this is the child’s first name listed on their COE. The field is not case sensitive.

D. **Child Last Name** = this is the child’s last name listed on their COE. Do not include a suffix (if any). The field is not case sensitive.

E. **Child DOB (MM/DD/YYYY)** = this is the child’s date of birth listed on their COE. The field will accept M/D/YYYY as well.

F. **VPK Program Year** = this is the child’s approved VPK program year listed on their COE. The field is looking for the first 4-digit year only. For example, if the VPK program year is 2017-2018, the entry would be
2017. Generally, the 4-digit VPK program year matches the year included at the end of the child’s COE number.

G. **Class ID** = this is the desired class’s 4-digit ID. The class ID must be entered as the 4-digit assigned ID. Do not include the class name (if any). Looking at the example below, the entry would be “AS17” not “Songbirds” or “AS17-Songbirds.”

![Example Image](image-url)

H. **Anticipated Start Date (MM/DD/YYYY)** = this is the date the child will begin attending class. Typically, this is the class start date unless the child is starting after the class begins.

**NOTE:** An anticipated start date cannot be before the class start date or after the class end date. And, an anticipated start date cannot be before the child’s COE issue date. The field will accept M/D/YYYY as well.

I. **MSID (XX-XXXX)** = this field is for public schools only. Public schools may enter their Master School Identification (MSID) number in a 6-digit format, where the first 2 digits are the district number followed by a hyphen and 4-digit school number. The MSID number can be used in lieu of the Provider ID in column A. Both IDs are accepted.

When the file is complete, name it and save it as a CSV file type.

**NOTE:** It may be helpful to include the provider name and class in the file name if troubleshooting is ever necessary.
When changing the file format to CSV, Excel often displays a message to ask if you want to keep using that format. If this message appears, click Yes.

Click the **Upload** button. A window displays. Select your file and click **Open**.

The file upload will begin. The file details will populate on a row and turn green. Click the **Refresh** button to populate the results.

The file details will be updated. The file size, total records count, committed records count, failed records count, processed time, status, and final results are updated. The file results are also returned and can be downloaded by clicking on the **Download** button.
In this example, there is one failed record and three committed records. The file download will include the error message and status for each record submitted. The three committed records are now “Enrollment Submitted” and the failed record was not included because of an invalid date of birth. The same validations that occur with a manual child enrollment occur with the bulk enrollment file process.

The three committed records are displayed on the class’s enrollment roster as “Enrollment Submitted” and the coalition receives the enrollment requests for review/approval/rejection. In addition, the family receives a notification that their child’s enrollment is in progress. The same processes that occur with a manual child enrollment occur with the bulk enrollment file process.

**NOTE**: When correcting records and re-uploading the file, be sure to remove the “Error or Status” column as it is not accepted for the upload. Also, it is best to NOT include records that have already been submitted successfully as they will now error as having been processed. When removing successful records and the Error or Status column, it is best to highlight the row/column and use the cut/delete option instead of just deleting the information. Excel often retains formats even if the cells are now empty.
VPK-20 Contract Verification

A provider must have a Certified VPK-20 contract on the Anticipated Start Date before an enrollment can be added. In the below example, the VPK application information is entered by the provider, and the + Enroll to this Class button is clicked.

In this example, the provider does not have a Certified VPK-20 contract, so an error message displays, alerting the provider that the enrollment cannot be submitted.

Warning: Enrollment cannot be submitted without a certified VPK-20 contract. Please contact your early learning coalition for assistance.
Enrollments - SR

Pending Family Acceptance Status

When a new School Readiness enrollment is created for an eligible child, families must accept the terms and conditions, establish their consent for developmental screening and/or child assessment, and sign the payment certificate. Families receive an email notification from DEL every five days until these steps are completed and the enrollment status changes from Pending Family Acceptance to Enrolled.

New enrollments in Pending Family Acceptance will not be visible on provider attendance rosters and will only appear once the family signs the payment certificate; however, there are exceptions.

- New enrollments for at-risk children (BG1) or at-risk children in relative care (BG3R) billing groups in Pending Family Acceptance will populate on attendance rosters
- Existing enrollments in Pending Family Acceptance that have already been submitted for attendance in previous months will continue to populate on attendance rosters

Providers will be able to process attendance and be paid for these enrollments, but not until the payment certificate is signed by the family.

If a provider has new enrollments in Pending Family Acceptance, when the provider accesses SR attendance, a pop-up window will display with a count of those new enrollments and a link to the Manage SR Enrollment queue.
Viewing Enrollments in Pending Family Acceptance
To view enrollments in Pending Family Acceptance, navigate to Enrollments > Manage SR Enrollments > View/Edit SR Enrollments > Pending Family Acceptance.

Ending Enrollments in Pending Family Acceptance
Providers can end enrollments in Pending Family Acceptance. Navigate to Enrollments > Manage SR Enrollments > View/Edit SR Enrollments > Pending Family Acceptance. Find the enrollment, then click the End Enrollment button.

A confirmation pop-up window displays. Click Yes to continue or No to stop the End Enrollment process.
After clicking the **Yes** button, the following pop-up window displays. Complete the required information and click **Save**.

![End SR Enrollment](image)

After clicking **Save**, a confirmation pop-up window displays. Click **Yes** to end the enrollment or **Cancel** to cancel the End Enrollment process.

![Confirm End Enrollment](image)

After clicking the **Yes** button, a pop-up window displays a message that the enrollment is ended. Click **Ok** to continue.
Canceling Enrollments in Pending Family Acceptance

Providers can cancel enrollments in **Pending Family Acceptance**, but only if the enrollment is not for an at-risk child (BG1) or at-risk child in relative care (BG3R) and attendance has not been submitted for the enrollment.

Navigate to **Enrollments > Manage SR Enrollments > View/Edit SR Enrollments > Pending Family Acceptance**. Find the enrollment, then click the **Cancel Enrollment** button.

A confirmation pop-up window displays. Click **Yes** to cancel the enrollment and remove it from the SR Enrollment queue. Click **No** to stop the Cancel Enrollment process.
SR Eligibility Redeterminations
The SR Eligibility Redetermination menu allows providers to view enrollments with “upcoming” or “past due” redeterminations. These queues are for informational purposes only and aid providers in knowing when an enrolled child is reaching the end of their School Readiness eligibility.

Upcoming Eligibility Redeterminations
To see the enrollments with upcoming eligibility redeterminations, navigate to Enrollments > Manage SR Enrollments > Redeterminations > Upcoming Redeterminations.

Redetermination records will only appear in the Provider Portal Upcoming Redetermination queue when:
- Child eligibility status is Eligible
- Child enrollment status is Enrolled or Pending Family Acceptance
- The redetermination is within 45 days from the due date

Past Due Eligibility Redeterminations
To see the enrollments with past due eligibility redeterminations, navigate to Enrollments > Manage SR Enrollments > Redeterminations > Past Due Redeterminations.

Redetermination records will only appear in the Provider Portal Past Due Redetermination queue when:
- Child eligibility status is Eligible
- Child enrollment status is Enrolled or Pending Family Acceptance
- The redetermination is at least one day past the redetermination due date

After clicking the Upcoming Redeterminations or Past Due Redeterminations link, the following appears.
Click the link for a child name in the Child Name column, and a pop-up message displays child eligibility and enrollment details for the child.

Click View in the Payment Certificate column, and a pop-up message displays the payment certificate for the enrollment. If the payment certificate does not exist, the View button will not be active, but hovering over the button displays a message: "The payment certificate is not viewable until signed by the parent."

NOTE: If the ELC changes the Household Eligibility Status from Redetermination to Active or Inactive, the child's eligibility will be removed from Redetermination status and the record(s) will be removed from the Provider Portal Redetermination queues.
Temporary Closures

Temporary closures must be created when the whole site or program or specific classroom is temporarily closed due to emergency circumstances. Provider and Coalition users can initiate temporary closures.

**NOTE:** Temporary closures must be created BEFORE attendance is submitted for the month in which the closure occurs.

To add a closure, navigate to **Attendance > Temporary Closures**

or use the **Click here!** link on the SR or VPK Attendance Roster.
Click the **Add Temporary Closure** button.

The Report Temporary Closure pop-up window opens.
Creating a Temporary Closure for a Whole Site Closure

Complete the form. Hover over the information icons for additional information.

- **Closed Provider Site(s)** – Select the site(s) that were temporarily closed due to emergency circumstances. Each site that the user has access to is listed. Only providers with VPK or SR enrollments display in the dropdown list.
  
  **NOTE**: If providers were closed for different dates, they should be unchecked and have separate closure events created.

- **Closure Details** – Enter the closure date range. The “Closed From” date is the first day of the closure and the “Closed To” date is the last day of the closure. A single day closure would have the same “Closed From” and “Closed To” date. No services are available on dates included in the closure date range.
  
  **NOTE**: The closure date range is limited to a single month. If the closure crosses into the next month, an additional closure is needed to cover that time period.

Clicking the No Services checkbox will select multiple providers with whole site closures and a pop-up will indicate that all classes and care levels are selected for all providers.

![Image of the form](image-url)
Unchecking the No Services checkbox will deselect all providers, but all classes and care levels for each provider are still selected. The user will need to deselect classes and care levels for each provider that should not be included in the closure.

- **Closure Reasons** – Select the applicable reason(s) for closure. If ‘Other’ is selected as the closure reason, then a comment is required.
- **Documentation** – Click the Upload Document button to upload necessary documents (optional).
- **Comments** – Enter comments related to the closure. If no comments are entered when the form is saved or submitted, the system will enter “Closure added by provider user” in the comments.

Clicking the Save button on the Report Temporary Closure form saves the record in “Incomplete” status. Incomplete closure forms can be seen by the coalition for assistance. To edit a temporary closure record, click the Edit button on the incomplete record.

Edit the closure details and click Submit to Coalition. After clicking the Submit to Coalition button, the Sign and Certify message appears. Complete the authorized electronic signature fields, then click Submit.
The temporary closure is submitted to the coalition. The record appears in the Submitted closures queue in “Submitted” status.

Creating a Temporary Closure for all or some SR Care Levels.
Complete the form. Hover over the information icons for additional information.

- **Closed Provider Site(s)** – Select the site(s) that were completely, temporarily closed due to emergency circumstances. Each site that the user has access to is listed. Only providers with a certified contract display in the dropdown list.
  
  **NOTE**: If providers were closed for different dates, they should be unchecked and have separate closure events created.

- **Closure Details** – Enter the closure date range. The “Closed From” date is the first day of the closure and the “Closed To” date is the last day of the closure. A single day closure would have the same “Closed From” and “Closed To” date. No services are available on dates included in the closure date range.
  
  **NOTE**: The closure date range is limited to a single month. If the closure crosses into the next month, additional closure is needed to cover that time period.

- **Reimbursement Requests** – Select the care level(s) impacted by the closure. Check the checkbox for the care levels to include it in the closure.
  
  **NOTE**: The days default to ‘CR’.

- **Closure Reasons** – Select the applicable reason(s) for closure. If ‘Other’ is selected as the closure reason, then a comment is required.

- **Documentation** – Click the **Upload Document** button to upload necessary documents (optional).

- **Comments** – Enter comments related to the closure.

- Clicking the **Submit** button submits the closure to the coalition. The record appears in the Closures grid with “Submitted” status. It is available in Coalition’s ‘Submitted’ queue.
  
  **NOTE**: The **Save** button saves the record in ‘Incomplete’ status.

- Complete the authorized electronic signature fields, then check the Certify by Electronic signature box, then click the **Submit** button.

- Clicking on CR changes the value to CN and vice versa.

- **PR5 August 2022**
• Clicking the **Submit** button submits the closure to the coalition. The record appears in the grid with “Submitted” status. It is available in Coalition’s ‘Submitted’ queue.

Once the submitted record is processed by the coalition, the record changes to **Processed** status.

**NOTE:**

1. When the status of the record is submitted, there is only a **View** button. The provider cannot edit or delete a temporary closure record that is in **Submitted** or **Coalition Reviewing** status.
2. **Incomplete** and **Processed** records can be deleted.
3. If a coalition adds more providers to the closure that the provider user does not have access to, there will not be a **Remove** button.
4. Individual students, not affected by a temporary closure, may be edited in SR attendance. For example, a 2 Year Old class has 6 children showing a CR for the temporary closure, but 3 of them were present on the CR days. The provider can change the CR days to an X to mark the 3 children present.
Creating a Temporary Closure for all or some VPK Classes.

Complete the form. Hover over the information icons for additional information.

- **Closed Provider Site(s)** – Select the site where some or all VPK classes were temporarily closed due to emergency circumstances. Each site that the user has access to is listed. Only providers with enrollments display in the dropdown list.

- **Closure Details** – Enter the closure date range. The “Closed From” date is the first day of the closure and the “Closed To” date is the last day of the closure. A single day closure would have the same “Closed From” and “Closed To” date. No services are available on dates included in the closure date range.

**NOTE:** The closure date range is limited to a single month. If the closure crosses into the next month, an additional closure is needed to cover that time period.
- **Classes and Reimbursement Requests** – Select the class(es) impacted by the closure using the checkbox.
  - The Missed Instructional Hours pop-up window opens.
    - Selecting ‘Yes’, marks the day as ‘Closure Non-Reimbursable’ (CN) in the calendar.
    - Selecting ‘No’, marks the days as ‘Closure Reimbursable’ (CR) in the calendar.
  - The days populate as CN – Closure Non-Reimbursable or as CR – Closure Reimbursable.
  - Clicking on CN changes the value to CR and vice versa.
- **Closure Reasons** – Select the applicable reason(s) for closure. If “Other” is selected as the closure reason, then a comment is required.
- **Documentation** – Click the **Upload Document** button to upload necessary documents (optional).
- **Comments** – Enter comments related to the closure. If no comments are entered when the form is saved or submitted, the system will enter “Closure added by provider user” in the comments.
- After clicking the **Submit to Coalition** button, the **Sign and Certify** message appears.

**NOTE**: Clicking the **Save** button saves the record in “Incomplete” status. The coalition can view incomplete forms.
• Complete the authorized electronic signature information, then click the **Submit** button.

• Clicking the **Submit** button submits the closure to the coalition. The record appears in the grid with “Submitted” status. It is available in Coalition’s ‘Submitted’ queue.
VPK Non-Reimbursable Temporary Closures
After the coalition approves a temporary closure that has non-reimbursable (CN) days, VPK providers must take additional steps to complete the process. When the temporary closure with non-reimbursable days is set to “Processed”:

1. The provider’s VPK provider application (VPK-APP) is changed to “Incomplete” status.
2. If the class(es) associated with the non-reimbursable closure shares a calendar with another class, the system separates the calendar so that each class that shared the calendar will have its own calendar. In other words, the original class calendar is cloned as many times as needed and each cloned calendar is assigned to a class so that all classes involved in the closure have its own calendar. (One of the classes will keep the original calendar.)
   • A new cloned calendar’s name consists of the word “Revised:” followed by the original calendar’s name and the associated class’s name in parenthesis.
   • If the original calendar does not have a name, the cloned calendar’s name will only consist of “Revised:” and the associated class’s name in parenthesis.

Example:

**Original Calendar:**

![Original Calendar Image]

**Cloned Calendar** assigned to class AF21:

![Cloned Calendar Image]

3. The non-reimbursable temporary closures for each class are automatically written to the original and/or cloned calendar as “Non-Instructional: Temporary Closure Added” in the correct service period month.

**NOTE:** When non-instructional temporary closure days are added to a VPK calendar, the Total Calculated Hours are reduced, so the provider must adjust the calendar to restore the calculated hours to “540”.

4. An email notification is sent to the provider advising that their VPK-APP is in non-certified status due to a temporary closure. The provider is instructed to log into the account to update and submit the VPK-APP to the coalition.
Update VPK Class Calendar

Providers must revise their VPK class calendar(s) in their VPK-APP to make up the hours for the non-instructional day(s) due to temporary closure (CN days). In the Provider Portal, navigate to the Contracts > Manage Contracts. Or, on the home page Common Tasks section, click the VPK Provider Application link.

On the Manage Contracts page, click the Edit button for the incomplete VPK-APP.

Click the VPK Calendars tab to open the calendars page.
Identify the calendar(s) with the non-instructional temporary closure days. Click the **Edit** button to make changes to a calendar. The system defaults to the first calendar month of the class. Click the forward arrow if needed to view the month with the closure.

![Calendar with non-instructional days highlighted]

The **Totaled Calculated Hours** will be reduced for each non-instructional day based on the hours defined for the day.

![Example of reduced calculated hours]

Make adjustments to the calendar to restore the hours to 540. This can be accomplished in a variety of ways such as:
- Canceling previously identified future non-instructional days
- Extending the class end date
- Extending the time on instructional days by creating Instructional Day Exceptions with different class hours
When the changes are done and the calculated hours are restored, click the **Save** button.

**NOTE:** These steps must be completed for each impacted calendar.

When all impacted calendars are updated, click on the **Certify and Submit** tab. Complete the signature information, then click the **Submit VPK Provider Application** button.

After clicking **Submit VPK Provider Application**, the VPK-APP status changes to “Submitted” and the application is available for the coalition to review.

**NOTE:** Since reimbursable temporary closure (CR) days do not reduce the total class hours, they will not be added to the VPK calendar.
## Attendance Rosters

After the temporary closure is processed by the coalition, the temporary closure days will show on SR and/or VPK attendance rosters as CR or CN.

**NOTE:** For VPK, if there were any CN days, the coalition must review the provider’s updates to the VPK calendar and set the VPK-APP status to Certified before attendance can be done.

In the blue header, the temporary closure details display the closure dates.

### SR Attendance Roster:

[Image of SR Attendance Roster]

A “◊” symbol indicates that the child’s care level is impacted by a temporary closure during the service period.
VPK Attendance Roster:

Class attendance has NOT been submitted to Coalition at this time.

Class: AF21-3hr AM
Max Class Size: 20
Start Date: 8/10/2021
End Date: 5/27/2022
Curriculum: Mother Goose Time
Edition: 2017

Temporary Closure (ID: 25242) 08/13/2021 - 08/20/2021

* Indicate the child’s attendance below. Supporting documentation may be uploaded to the Document Management Library as needed.

August 2021

After each child's attendance for the month is reviewed, it can be submitted to the coalition.
Attendance - VPK

Providers manage VPK attendance online by navigating to the Attendance menu item and selecting *Manage VPK Attendance*. Providers may submit their attendance through the web page or using a bulk file upload, similar to the bulk enrollment file upload. It is important to note that changes to enrollment, such as entering a termination date, or changes to the class schedule, such as reporting a site closure, cannot be performed in attendance. Enrollment information must be corrected in the Enrollments area. Class schedule information must be corrected in the *Contracts > VPK Provider Application* area. Any changes to source data should be done prior to submitting attendance. Coalitions may assist as needed.

Submitting Attendance Online

Select the *Manage VPK Attendance* menu item. The VPK Attendance Roster displays, defaulting to the current service period and first class. The blue summary box to the right contains class details such as the class full name, start and end dates, and max class size. If necessary, use the drop-downs to select a different service period and/or class.

**NOTE:** A service period is the month in which services were rendered. Child absences for the service period must be marked, saved, and submitted to the coalition for payment. A due date is displayed for each service period. Providers with multiple classes must submit an attendance roster for each class for payment.
The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing group, or status). The summary feature shows the current/saved attendance information for all children in one view.

To record attendance, click on a child’s name to view their attendance for the month.

- Days the site is closed are marked with an asterisk “*.”
- Days the child is scheduled to attend are marked with an “X” for present.
- A legend is provided in the bottom right for more code descriptions.

To change a present day to absent, click on the “X.” The “X” for present will now appear as an “A” for absent. Absences entered by mistake can be changed back to present by clicking on the “A.”

**NOTE:** With Release 6.0, the Person ID is now included in the “Child’s Current Information”:
While not required, it is recommended to click **Save** (below the calendar) before moving on to another child. When all child absences are marked for the month, click **Save** and then click the **Submit to Coalition** button. A window may appear if the attendance is being submitted early or late, or if no absences have been recorded. To continue to the **Sign & Certify** page, click **Continue**.

The **Sign and Certify** page displays the class summary with the total number of days absent and days present. At this point, providers may want to print this page using the browser print function. When ready, review the certification statements and complete the Authorized Electronic Signature portion by entering the user’s Full Name, checking the box for **Certify by electronic signature**, and clicking **Submit**. To abandon the submission, click **Cancel**.
Submitted Attendance

Upon submission, the screen returns to the VPK Attendance Roster view with the current service period displayed. Select the submitted service period from the drop down. The submitted roster now has a submitted message and each child shows “SUB” for submitted in the status column. This status will change as the child attendance is processed by the coalition.

Rejected Attendance

Coalition staff may reject submitted attendance. In this case, the individual that submitted the roster will receive an email notification. Instructions are provided to log in to the Provider Services Portal, review the roster, make necessary changes to rejected records, and re-submit. The rejected child records are displayed at the top of the roster list in red and show “REJ” for rejected in the status column. Only records with “REJ” may be edited.

To edit, click the name of a rejected record. Any absences previously recorded appear. Make changes as needed. After the last record is corrected, click Save. Then, click the Submit to Coalition button and continue to the Sign & Certify page. This time, the Sign & Certify page only shows the rejected records that are being re-submitted to the coalition. Complete the Authorized Electronic Signature portion and click Submit.
Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."

Approved Attendance
Coalition staff will continue to work submitted attendance until the records are approved for payment. Approved records appear on the attendance roster as "APP" for approved in the status column.

When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under Attendance > Reimbursement Details.
Providers can run a Payment Period or Service Period Reimbursement Report.

Uploading Bulk Attendance File

Providers may submit their attendance via a bulk file upload (similar to the enrollment bulk file upload process). To begin, go to the Attendance menu item, choose Manage VPK Attendance, and then select **Bulk File Upload**.

The Bulk VPK Attendance page displays.

Click the **CSV file template** link. A window appears. From this window, select the service month and year to generate a file for all of the enrollments (for all classes) at the site that month. Alternatively, multi-site providers may check the "**Include all providers for provider principal**" box to generate a file for all of the enrollments (for all classes) at all sites associated to the account for that month. Then, click the **Download** button.
Open the downloaded file. The enrollment information for each class is pre-populated. Each instructional day during the student's enrollment defaults to present (X).

- **Legend:** present (X), site closed (*), student not started (_), student terminated (T).
- **Day_1** = first of attendance month, **Day_2** = second day of attendance month, **Day_3** = third day of attendance month, etc. In this example, **Day_1** = August 1, **Day_2** = August 2, and **Day_3** = August 3.
- Regardless of the month/year, columns for **Day_1** to **Day_31** are included in the file and are necessary for the upload; none should be removed.
- It is critical that only the content of "Day_#" columns are changed (i.e. changing an X to an A). Attempting to add students or edit/remove system generated columns will cause errors. The file is a reflection of the enrollment information for the class when downloaded. If issues are identified, please contact the local early learning coalition for assistance.

**Scroll over to the days and record absences by changing a present day (X) to absent (A).**

**Tip:** (In Excel) Open the **View** menu, select column H, and click **Freeze Panes**. This will keep the student's name and demographic information in view while scrolling through days.

(In Excel) When complete, un-hide and/or un-freeze any columns. Click **File > Save As**. Re-name file and save locally. Be sure the file type is .csv.
On the Provider Portal, click the **Upload** button. A file manager window opens. Locate the saved file and click **Open**.

The uploaded file displays in the Bulk VPK Attendance log.

Click the **Refresh** button to get final results.

The successfully submitted attendance is now reflected on the class attendance roster. Each record shows "SUB" for submitted.
Attendance - SR

Providers manage SR attendance online by navigating to the Attendance menu item and selecting **Manage SR Attendance**. Providers may submit their attendance through the web page. It is important to note that changes to enrollment, such as entering a termination date, cannot be performed in the attendance module but rather the Manage SR Enrollment area. Also, when issues appear on the attendance roster (such as incorrect enrollment information, missing children, duplicate children, missing paid holidays, duplicate absences on the same day, etc.), the issues should be communicated to the coalition before submitting the attendance roster. Coalitions may assist in addressing the issues so that the attendance records have accurate information.

**Submitting Attendance Online**

Select the **Manage SR Attendance** menu item. The SR Attendance Roster displays, defaulting to the current service period. The blue summary box to the right contains provider details and paid holiday information for the service period.

**NOTE:** A service period is the month in which services were rendered. Child absences for the service period must be marked, saved, and submitted to the coalition. A due date is displayed for each service period. Providers that contract with multiple coalitions must submit an attendance roster to each coalition.

Children that are “Enrolled” are included on the SR attendance roster.
New enrollments in “Pending Family Acceptance” will not be visible on attendance rosters and will only appear once the family signs the payment certificate; however, there are exceptions.

- New enrollments for at-risk children (BG1) or at-risk children in relative care (BG3R) billing groups in Pending Family Acceptance will populate on attendance rosters
- Existing enrollments in Pending Family Acceptance that have already been submitted for attendance in previous months will continue to populate on attendance rosters

If a provider has new enrollments in “Pending Family Acceptance”, when the provider clicks the Manage SR Attendance menu item, a pop-up window will display with a count of those new enrollments and a link to the Manage SR Enrollment queue.

See the Pending Family Acceptance Status section in this user guide for more information.
The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing group, or status). The summary feature shows the current/saved attendance information for all children in one view.

To record attendance, click on a child’s name to view their attendance for the month.

- Days the site is closed are marked with an asterisk “*”
- Days the child is not scheduled to attend are marked with “NS”. If the entire month for a child is marked “NS”, contact the local early learning coalition to correct the care days.
- Days the child is scheduled to attend are marked with an “X” for present along with his/her scheduled unit of care
- Paid holidays where a child is also scheduled to attend are marked with an “H”
- A legend is provided in the bottom right for more code descriptions

**NOTE:** The “Child’s Current Information” displayed on the right is current as of today. When working prior months, the information displayed may not align. For example, if a child’s enrollment was terminated in February 2019, the current enrollment status is *Enrollment Ended*. Each month (prior to February) will also display *Enrollment Ended* in the “Child’s Current Information” area because it is the current enrollment status. This does not impact the ability to record attendance for those prior months. Enhancements are planned to address the display.

With Release 6.0, the Person ID is now included in the “Child’s Current Information”:

To change a present day to absent, click on the “X.” A pop-up message appears to collect more information.

a. Select an absent reason from the dropdown.
b. Include a message to the coalition regarding the absence in the Note area. *(optional for most reasons)*

c. Attach a file for supporting documentation by clicking Choose File. *(optional)*

d. Click Save when done and the pop-up message will close.

e. The “X” for present will now appear as an “A” for absent.
f. Consecutive absences can be entered by using a date range. A document can be attached to the absence range and the document will be associated to every day entered in the date span.

g. Absences entered by mistake can be changed back to present by clicking on the “A.” The below pop-up message appears. To undo the absence, click the **Remove Absence** button. That day will show an “X”, the absence reason is removed, and the attachment is removed.

![Absence Entry](image)

Note:

- **X** - Enrolled/Present – Allows Date Span Absence
- **A** - Absent – Allows Date Span Absence
- **CR** - Reimbursable Temporary Closure Day - Partial – Allows Date Span Absence
- **CN** - Non-Reimbursable Temporary Closure Day – Partial – Allows Date Span Absence
- **N** - Non-Reimbursable Day – Does Not Allow Date Span Absence
- **NS** - Non-Scheduled Day – Does Not Allow Date Span Absence
- **H** - Paid Holiday – Does Not Allow Date Span Absence
- **T** - Terminated/Enrollment Ended – Do Not Allow Date Span Absence
- **C** - Closed – Does Not Allow Date Span Absence
- **CR** - Reimbursable Temporary Closure Day - Whole Site – Does Not Allow Date Span Absence
- **CN** - Non-Reimbursable Temporary Closure Day - Whole Site – Does Not Allow Date Span Absence
- **X** - Attendance has not started – Does Not Allow Date Span Absence
While not required, it is recommended to click Save (below the calendar) before moving on to another child. When all child absences are marked for the month, click Save and then click the Submit to Coalition button. A window may appear if the attendance is being submitted early or late, or if no absences have been recorded. To continue to the Sign & Certify page, click Continue.

The Sign and Certify page summarizes the information for each child and an electronic signature is required.
Submitted Attendance

Upon submission, the screen returns to the SR Attendance Roster view with the current service period displayed. Select the submitted service period from the drop down. The submitted roster now has a submitted message and each child shows “SUB” for submitted in the status column. This status will change as the child attendance is processed by the coalition.

Rejected Attendance

Coalition staff may reject submitted attendance. In this case, the individual that submitted the roster will receive an email notification. Instructions are provided to log in to the Provider Services Portal, review the roster, make necessary changes to rejected records, and re-submit. The rejected child records are displayed at the top of the roster list in red and show "REJ" for rejected in the status column. Only records with "REJ" may be edited.
To edit, click the name of a rejected record. Any absences previously recorded appear. Make changes as needed. After the last record is corrected, click **Save**. Then, click the **Submit to Coalition** button and continue to the **Sign & Certify** page. This time, the **Sign & Certify** page only shows the rejected records that are being re-submitted to the coalition. Complete the Authorized Electronic Signature portion and click **Submit**.

Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."
Approved Attendance
Coalition staff will continue to work submitted attendance until the records are approved for payment. Approved records appear on the attendance roster as "APP" for approved in the status column.

When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under Attendance > Reimbursement Details.

Providers can run a Payment Period or Service Period Reimbursement Report.

NOTE: These reports have been enhanced to include children who are dismissed to get the registration fee. A dismissed child will show as $0.00 in the reports.
Request for Registration Fee Payment

Registration Fee Payments can only be requested by a provider. To request a Registration Fee, navigate to Enrollments > Manage SR Enrollments > Registration Fees > Eligible for Payment

Eligibility Rules for Registration Fee payments:

- Children are/were enrolled during the 2020-2021 program year.
- Children have not been paid more than 2 times in 5 years (or three with a hardship). Payments from 2019-2020 are excluded.
- Children with the BG1-ESS billing group and eligibility code are not eligible.
- Children “dismissed” by the provider for payment for the program year are not eligible.
- Children enrolled 3 months or less with expulsion reasons (Safety of Other Children or Behavior Problems) are not eligible.

The Registration Fee Payments screen lists children who are eligible for Registration Fee payments. To request a payment, check the checkboxes and click Request Payment button.
On the Request Payment pop-up, check the **I certify** checkbox and click **OK**. The record will be available for the coalition to Approve, Reject, or mark Ineligible.

**Dismiss Children**

If the provider has collected the registration fee from the family, the child is not eligible for a registration fee payment. To dismiss children from the list of registration fee payments, check the checkbox and click **Dismiss Children** button. Hovering over the **Dismiss Children** button will display the following message: “Remove all selected children from this list and indicate that payment is not expected from the coalition.”
The Dismiss Children pop-up window opens. Click the **OK** button to confirm dismissing the child(ren) from the list of registration fee payments. The Provider won’t be able to resubmit these children for registration fee payment.
SR Reimbursement Rate Plan

Providers can view their reimbursement rate plans in the Provider Portal. Navigate to Attendance > SR Reimbursement Rates.

The Coalition dropdown shows all the coalitions the provider has a contract with. The Rate Plan Period dropdown displays all the rate plans available based on the selected coalition. Clicking the Reimbursement Rates button will navigate to the SR Reimbursement Rates screen.
After clicking **Reimbursement Rates**, the SR Reimbursement Rates show for the selected coalition and rate plan period. The rates show the rates and differentials used to calculate reimbursement for the provider as shown in Exhibit 5 of the contract. The provider can view the rates for different units of care by selecting an option from the Unit of Care dropdown menu. Clicking the **View Provider Rates** button will navigate to the Provider’s Private Pay Rates.

The rates are read-only. The rates in the Provider’s Pay Rates screen are the rates that display in Column A of the SR Reimbursement Rates screen. Clicking the **Back** button will navigate to the SR Reimbursement Rates screen.
From the SR Reimbursement Rates screen, clicking the **View Differential Rates** button will navigate to the Provider’s Differential Rates screen. Clicking the **Back** button will navigate to the SR Reimbursement Rates screen.

![SR Reimbursement Rates screen](image)

From the SR Reimbursement Rates screen, clicking the **Sample VPK Wrap Calculation** link opens a pop-up with a sample calculation. Clicking the **Back** button will navigate to the SR Reimbursement Rates screen.

![Sample VPK Wrap Calculation](image)
Sample VPK Wrap Calculation

This is an example of a VPK wrap calculation for a child enrolled in both SR and VPK. The VPK class is 3 hours long and the child has full time care.

NOTE: The calculations are to 4 decimal places until the Gross Payment Amount, where it is rounded.

**How are wrap rates calculated?**

1. Provider Contract Approved Rate
2. Hourly Rate = Daily Rate/Max SR Hours [calculated to 4 decimal places]
3. Payable Hours = Max SR Hours - VPK Hours
4. SR Daily Rate = Payable Hours * Hourly Rate [calculated to 4 decimal places]
5. Gross Payment Amount = SR Daily Rate * Total Days Paid [calculated to 4 decimal places]

**Example:**

1. Provider Contract Approved Rate (PR4): $24.50
2. Hourly Rate: $24.50/11 = $2.2237
3. Payable Hours: 11 - 3 = 8
4. SR Daily Rate: 8 * $2.2237 = $17.8184
5. Gross Payment Amount: $17.8184 * 20 = $356.3680

For this record on the 5045, the provider is reimbursed for $356.37.